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DIABLO ANALYTICAL, INC. SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY 
 
LICENSE AGREEMENT 
 
IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to 
use this software product is sold only on the condition that the customer agrees to the following license.  
INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 
 
In return for payment of the one-time license fee for this software product, Customer receives from Diablo 
Analytical, Inc. (Diablo) a license to use the product subject to the following terms and conditions: 
 
Use:  The product may be used one computer or workstation.  A separate license agreement and fee is 
required for each additional computer or workstation on which the product is used.  Customer may not 
reverse assemble, decompile, or modify the software. 
 
Copies:  The software product may not be duplicated or copied except for archive purposes, program error 
verification, or to replace defective media, and all copies made must bear the copyright notices contained in 
the original. 
 
Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to 
Customer except as specifically set forth in this License Agreement.  Customer is on notice that the software 
product is protected under copyright laws. 
 
Transfer of Rights:  This license and the software product may be transferred to a third party, with prior written 
consent from Diablo, provided the third party agrees to all the terms of this License Agreement and the 
Customer does not retain any copies of the software product. 
 
Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software 
to the public in physical media or by telecommunication without the prior written consent of Diablo. 
 
Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, 
Customer will either return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo 
with a certificate of destruction of all copies. 
 
Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which 
may be available from Diablo in a separate support agreement. 
 
Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the 
U.S. Export Administration regulations or other applicable regulation. 
 
LIMITED WARRANTY 
 
Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of 
delivery of the software. 
 
No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any 
warranty for the software product.  The software product and any related documentation is provided "as is" 
without warranty of any kind, either express or implied, including, without limitation, the implied warranties or 
merchantability of fitness for a particular purpose.  The entire risk arising out of use or performance of the 
software product remains with the customer. 
 
Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy 
under this license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or 
(b) replacement of the software that does not meet Diablo's Limited Warranty and which is returned to Diablo 
with a copy of the customer's receipt.  Any replacement software will be warranted for the remainder of the 



 

 

original warranty period, or 30 days, whichever is longer.  These remedies are not available outside the 
United States of America. 
 
No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event 
shall Diablo be liable for any damages whatsoever (including, without limitation, damages for loss of business 
profit, business interruption, loss of business information, or any other pecuniary loss) arising out of the use or 
inability to use the product, even if Diablo has been advised of the possibility of such damages.  Because 
some states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental 
damages, the above limitation may not apply to you. 
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Introduction 

MS Sensor Overview 
The MS Sensor software is designed to allow simple, yet flexible, acquisition and display of 
continuous process data using the Agilent Technologies 5975 or 5977 MSD and other kinds of 
instruments and sensors like the MKS PDR2000 pressure controller. 

Features 

• Enables Mass Spectrometers controlled by the Agilent Technologies MassHunter 
GC/MS data system to be used for continuous process analysis. 

• The software architecture allows real-time data to be acquired from multiple kinds of 
instruments and sensors. 

• User-defined formulas can be defined and applied to instrument signal data in real time.  
This allows ratio, normalization, and other calculations to be performed and displayed in 
real time. 

• A linear calibration function can easily be generated for Signals. 

• Up to 6 trend-plot windows can be used to display graphical results in real time. 

• A real-time data grid displays numeric results in real time. 

• Results can be exported to comma-delimited (CSV) text files that can be easily imported 
into spreadsheets and other data analysis or modeling applications. 

• An event log allows logging of user notes, system messages, and error and warning 
alerts. 

New Features in MS Sensor 4.0 

• Results are saved to a SQLite database data file allowing contents to be read in real-
time during a run. 

• A new MS Sensor Data Viewer program can open MS Sensor data files and allow you to 
view and evaluate data channel results during the run or post run. 

• New signal calibration functionality incorporates pressure compensation calculations, 
and simplifies calibrations.  Signals can be calibrated during a run. 

• You can import applications from the new MS Sensor Application Builder software. 
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• Includes a new Modbus TCP Slave Server to communicate results with industrial 
automation computers and programmable logic controllers. 

• The Agilent MassHunter instrument driver now has an optional dual-scan capability that 
allows alternating mass spectra to be acquired with different tune files, SIM/Scan mode, 
different detector voltages, etc. 

• The Agilent MassHunter instrument driver now includes an option for a Helium 
optimization tune in addition to the Hydrogen optimization tune. 

• Data Channel results can now be calculated and displayed as the current result, the 
average of “n” consecutive results, or the moving average of the last “n” results. 

• Trend plot line colors and plot titles can now be customized.  Data Channels can be 
assigned to different plot windows during the run. 

• The software license can be activated automatically if the computer has an Internet 
connection. 

• The software has an option to check for software updates if the computer has an Internet 
connection.  

5000B Real-Time Gas Analyzer 

The Diablo 5000B Real-Time Gas Analyzer (RTGA) combines the MS Sensor software with an 
Agilent Technologies 5977 MSD and a high-performance, differentially-pumped direct sampling 
interface.  The Real-Time Gas Analyzer is a real-time chemical measurement tool for continuous 
process improvements.  It is ideal for applications where very fast analysis is required, such as 
monitoring for transients and continuous reactions. The Diablo RTGA can be used for fuel cell gas 
analysis, syngas monitoring and many other applications. 
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The Diablo 5000B Real-Time Gas Analyzer (RTGA) 

Contact Diablo Analytical for more information about the 5000B Real-Time Gas Analyzer. 

Diablo Analytical, Inc. 
Diablo Analytical is an analytical application development company located in Antioch, CA.  We 
specialize in gas-phase chemical measurement solutions using gas chromatography, mass 
spectrometry, infrared detection, pyrolysis, and software development. 

Our company is named after Mount Diablo, a nearby 3849’ peak in the San Francisco Bay Area. 

Diablo Analytical, Inc. 

5141 Lone Tree Way 

Antioch, CA  94531 

Phone:  (925) 755-1005 

Fax: (925) 755-1007 

E-Mail: support@diabloanalytical.com 

WWW:  http://www.diabloanalytical.com 

Software Requirements 
The MS Sensor 4.0 software is compatible with Windows 7 SP1, Windows 8/8.1, and Windows 10. 

The .NET Framework 4.5.2 must be installed before trying to run Application Builder.  The .NET 
Framework will be installed automatically, if necessary, when you install the software from the 
distribution media, or if you use the single-file installer.  If you use the web-based installer the .NET 
Framework 4.5.2 will be downloaded automatically if necessary.  You can also download and install 
the .NET Framework 4.5.2 from Microsoft using the following link: 

https://www.microsoft.com/en-us/download/details.aspx?id=42642 

Note: The .NET Framework 4.5.2 is included with all versions of the Windows 10 operating system. 

Agilent 5975/5977 MSD 

Currently MS Sensor 4.0 only supports mass spectrometers that are controlled by the Agilent 
MassHunter GC/MS data system.  Instruments that are controlled by the older MSD ChemStation 
software will need to be upgraded to MassHunter before they can be used with MS Sensor 4.0. 

In addition, MS Sensor 4.0 requires MassHunter GC/MS version B.07.05 or later. 

Installation 
Important:  If this software will be used with an Agilent Technologies 5975 or 5977 MSD, you must 
first install the MassHunter GC/MS Acquisition software and confirm that it is operational by 
performing a successful autotune before installing the MS Sensor software. 

The MS Sensor 4.0 software is installed by running the setup program on the distribution flash 
drive/CD, or the installation program downloaded from our web site. 

https://www.microsoft.com/en-us/download/details.aspx?id=42642


Introduction 

4 MS Sensor 4.0 Reference Manual 

Important:  You must be logged on with Administrator privileges when you install the software (but 
you can run the software thereafter as a standard user) 

There are two different versions of the installation program that can be downloaded from our web 
site: 

1. A web-based installer that should be used to update an existing installation of the software 
or to install the software on a computer that has Internet access.  This version of the installer will 
download the required .NET Framework 4.5.2 files automatically over the Internet if required. 

2. A single-file installer that should be used to install the software on a computer with no 
access to the Internet.  This version of the installer includes the.NET Framework 4.5.2 and is 
consequently much larger in size. 

Note: The .NET Framework 4.5.2 is included with all versions of the Windows 10 operating system.  
Consequently, you should use the web-based installer to install Application Builder onto a computer 
running Windows 10. 

Software Licensing and Activation 
When you run the software for the first time, you will have a trial license that allows you to use and 
evaluate the program for up to 30 days.  The program is fully-functional during the trial period.  In 
order to continue using the software after the 30-day trial period, you must purchase a license and 
then activate the software. 

To activate your license, click the “Activate License” button on the License Status window that is 
displayed when you start the software or when you click the menu option, “Help > License 
Status…”. 

 

 

When you purchase your software license, you will receive a 31-character Serial License Code (this 
is different than the shorter Serial Number).  To activate the software, you must enter that License 
Code into the text box on the “Activate License” window.  If you copy the Serial License Code to the 
Windows Clipboard from an email message, you can paste into the text box using the “Paste” 
button.  Alternatively, if you received a text file containing the Serial License Code, you can load it 
using the “File Open” button. 

Note: If you received a distribution USB flash drive, a text file containing your serial license code 
may be saved on the flash drive. 
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After entering the Serial License Code, click the “Apply” button.  If your computer is connected to 
the Internet, the software will contact the License Server and automatically activate the software. 

If your computer is not connected to the Internet, or if there is a problem contacting the License 
Server, then you will need to activate the software manually by clicking the “Manual” button and 
following the instructions. 

Refer to the Software License Guide for more information about licensing and activation. 

Note: An Internet connection is only required when applying an activation code or deactivating the 
software.  No Internet connection is required during normal operation of the software. 
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Getting Started 

Main Application Window 
The main MS Sensor application consists of a main menu, a toolbar, and several windows that 
perform specific functions, including the acquisition control panel, the event log, the real-time data 
grid, and one or more real-time trend plot windows. 
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Main Menu 
The following options are accessed through the MS Sensor main menu: 
 

File  

Export Results to Text 
File: 

Export the results from a data file to comma-delimited (CSV) text 
files.  See “MS Sensor Text Files” on page 66. 

Exit: MS Sensor will shut down all instruments, close all windows and 
exit immediately.  If the system is acquiring data, then the 
acquisition will have to be stopped before you can exit from MS 
Sensor. 

Method  

New Method: Prompts you for a method name and then displays an "empty" 
method in the method editor. 

Open Method: Displays a window allowing you to open an existing method and 
display it in the method editor. 

Edit Method: Opens the currently loaded method in the method editor. 

Calibrate Signals: Displays the signal calibration window.  See “Signal Calibration” on 
page 42. 

Import: Allows you to import an MS Sensor 3.0 method, or import an 
application from the MS Sensor Application Builder software.  See 
“Import MS Sensor 3.0 Methods” on page 35 and “Import 
Application from Application Builder” on page 36. 

Tools  

Enable Debug Logging: Toggles the log file between debug mode and standard mode. 

View Log File: Opens the current log file in Windows Notepad. 

Browse System Folders: Opens various MS Sensor system folders in the Windows file 
explorer. 

Save Support Files to 
Archive: 

Save software log files, and optionally method and data files to a 
“zip” archive file that can be sent to Diablo Analytical support 
personnel to help troubleshoot problems.  See “Support Files 
Archive” on page 130. 

Window  

Cascade: Rearranges all open MS Sensor Windows so they are overlapped in 
"cascading" fashion. 

Tile Horizontal/Vertical: Rearranges all open MS Sensor Windows so that they are tiled next 
to each other, filling the main window of the application. 

Display Trend Plot 
Windows: 

Allows you show/hide any of the 6 trend plot windows.  This menu 
option is only visible when the acquisition status is “Ready”, 
“Running”, “Paused”, or “Finished”. 

Help  
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View Help: Displays the contents page of the MS Sensor Help file. 

View Release Notes: Displays the current MS Sensor Release Notes in an Internet 
browser window. 

License Status: Displays the software license status window. 

Check for Software 
Update: 

If the computer is connected to the Internet, this function will check 
if an update to the software has been released, and if so, allow you 
to download and install the update. 

About MS Sensor: Displays a window that contains information about the MS Sensor 
software, including the current revision number. 

Main Toolbar 
The main MS Sensor toolbar contains the following buttons: 

 

 

Button Description 

New Method: Prompts you for a method name and then displays an "empty" method in 
the method editor. 

Open Method: Displays a browse window allowing you to open an existing method and 
display it in the method editor. 

Edit Method: Opens the currently loaded method in the method editor. 

Import: Displays a “wizard” to help you import an application from the MS Sensor 
Application Builder software.  See “Import Application from Application 
Builder” on page 36. 

Calibrate: Displays the signal calibration window.  See “Signal Calibration” on page 
42. 

Acquire: Displays the Acquisition Control Panel that is used to initialize and start a 
run using the current method. 

View Data: Opens the current data file in the MS Sensor Data Viewer program.  Data 
files can be opened and viewed during the run. 

Method Overview 
MS Sensor methods define the instrument and acquisition conditions for a process analysis 
experiment as well as the real-time data processing and display methodology. 

Method Components 

MS Sensor methods consist of the following "components": 
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Component Description 

Instruments Instruments are signal-generating devices.  A specific software driver 
(instrument plugin) must be written for each instrument whose signal will be 
acquired by the MS Sensor software.  In addition to the Agilent Technologies 
5975/77 MSD, an instrument driver has been written for the MKS PDR 2000 
pressure controller. 

Signals Signals produce numeric values that are the foundation of an MS Sensor 
method.  The signal settings defines what result will be retrieved from a 
particular instrument's signal data. 

Calculations Calculations use a custom, user-defined formula to perform calculations in 
real time.  The formula can include Signal values as well as constants, 
mathematical operators, and a number of mathematical functions. 

Data Channels Data Channels are the top-level components that are plotted and displayed in 
real time.  Data Channels are also defined by a custom formula that can 
include both Signals and Calculations. 

Component Processing Flowchart 

The following flow chart illustrates how MS Sensor methods and method components are 
processed during a run. 
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Editing Methods 

Methods are edited using the method-editing window, which consists of two panels.  Method 
components are displayed in a tree on the left panel, while the current parameters for a selected 
component are displayed on the right panel. 

Instruments
Acquire raw signal data from Instrument

Signals
Apply Signal recipe to raw Instrument signal to generate signal response

Data Channels
Apply Signal or Calculation response to Data Channel formula to generate

Data Channel response

Signal Recipe
Defines how raw Instrument signals

are processed in order to generate a

Signal response

Data Channel Recipe
Defines the formula to which Signal or

Calculation response value(s) will be

applied to generate a Data Channel

response

Sum, Ratio, Difference, Average

Custom Formula

Instrument Recipes
Defines the Instrument parameters and

condtions that will be used to generate

the raw signal

Method

Calculations
Apply Signal response to Calculation

formula to  generate Calculation

response

Inst1 Inst2

Sig1 Sig2 Sig3 Sig4 Sig5 Sig6

Calc1 Calc2 Calc3

Chan1 Chan2 Chan3 Chan4 Chan5 Chan6

Calculation Recipe
Defines the formula to which Signal

response value(s) will be applied to

generate a Calculation response

Sum, Ratio, Difference, Average,

Custom Formula

Acquisition and Component Processing

Flowchart

Update Real-time Trend Plot, Data Grid, and Data Channel Log File  with

Data Channel Response values
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The MS Sensor Method Editor 

See “Method Editor” on page 21 for more information. 

Acquiring Data 

The acquisition of process data is controlled using the Acquisition Control Panel.  To display the 
control panel, click the “Acquire” button on the main toolbar. 

The Acquisition Control Panel includes a toolbar to control the run, Run Status, and Run Time 
panels, and an instrument table displaying the status of the individual instruments in the method. 

 

The MS Sensor Acquisition Control Panel 

See “Acquisition Control Panel” on page 53 for more information. 
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Event Log 
The MS Sensor Event Log window is where system events, errors, and system and user messages 
are displayed.  The event log is a SQLite database and is automatically loaded when the software is 
started.  Events will remain in the log until the log is cleared.  All events that occur during a run are 
automatically saved to the data file. 

 

MS Sensor Event Log 

Filter Events 

You can filter the events that are displayed in the event log using the filter list box in the toolbar. 

 

Filter Description 

Today Display only events that were added to the log on the current day. 

All Events Display all events currently in the event log.  Note that if a large number of 
events are present in the log, there may delay in updating event log table. 

Warnings Display only events with “Warning” status. 

Errors Display only events with “Error” status. 

Acknowledge Errors and Warnings 

When an error or warning event is received by the event log, that line in the event table will be 
highlighted with either a red background (error) or yellow background (warning).  In addition, the 
current number of errors and warnings are displayed in the event log toolbar.  To acknowledge an 
individual error or warning, double click the entry in the event table, and an event summary window 
will be displayed.  If the event is an active error or warning, then the "Acknowledge" button is 
enabled. 

All errors or warnings in the event table can be acknowledged by pressing either the "Acknowledge 
all errors" or "Acknowledge all warnings" toolbar buttons. 
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Display Event 

If you double click on an event in the Event Table, the "Display Event" window will be displayed: 

 

MS Sensor Display Event Window 

If the event is an error or warning, the "Acknowledge" button can be pressed.  This will cause the 
Event Status to change from "Warning" or "Error" to "Ack", and the Warning or Error count on the 
main Event Log window will be decremented by 1. 

Pressing the “Copy” button will cause the current event detail to be copied to the Windows 
Clipboard. 

Add User Event 

A custom message can be inserted into the event log by pressing the "Add Event" toolbar button.  A 
window will be displayed allowing the user to enter the text of the message that they want to add to 
the event log.  This can be a useful way to record process observations during a run. 
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Click the “Update” button to update the event Run Time and Date/Time. 

Clear Event Log 

The event log can be cleared by clicking the "Clear Events" button on the Event Log toolbar.  You 
have the option to clear all events, clear events older than 1 month, clear events older than one 
year, or clear events older than a specified date.  You can also backup the event log database 
before clearing events. 

 

Running the Demonstration Method 
A demonstration method, “demo.mssmet”, is installed with the MS Sensor software.  This demo 
method uses "simulator" instruments that produce random signal data for the purposes of testing 
and software familiarization.  The following steps describe how to load and run the demonstration 
method. 
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1. Click the “Open Method” button on the main toolbar and select the demo method, 
“demo.mssmet”: 
 

 
 

2. Click the "Acquire" button on the main toolbar.  The Acquisition Control Panel will be 
displayed: 
 

 
 
The demo method includes two instruments:  the "MS Simulator" and the "Pressure 
Simulator".  The initial status of both instruments is "Offline". 
 

3. Next, press the "Initialize" button.  You will be prompted to specify a data file for this run.  
MS Sensor data files are actually folders with a ".D" file extension.  The ".D" extension will 
be added automatically for you.  You can also enter an optional sample name, user name, 
and sample description: 
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4. Once you click the “OK” button on the Sample Information window, the instruments will be initialized, 
brought online, and will reach “Ready” status indicating that they are ready to start a run: 
 

 
 

In addition to bringing the instruments to Ready status, "Initialize" also loads the trend plot 
and data grid windows.  If you have run the method before, the windows will be restored to 
their last positions.  However, if this is the first time you have run the method, you may need 
to position the windows manually to your liking.  You can use one of the "Tile" options of the 
"Window" menu as a starting place. 

5. Start the run by pressing the "Start" button.  The instrument status will switch to "Running", 
and you should see data start to appear in the real-time grid window and the trend plot 
windows: 
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6. The demo method is configured to run continuously until you press the "Stop" button.  Press 
the “Stop” button and wait for the system to reach “Finished” status: 
 

 
 

7. You can view the Data Channel results in the MS Sensor Data Viewer by clicking the “View 
Data” button in the main toolbar. 
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Methods 

Default and Demo Methods 
The following default methods are installed with the MS Sensor application: 
 

Method Description 

DEFAULT.M The default method set up for the Agilent Technologies 5975 or 5977 
MSD using MassHunter GC/MS control and an MKS PDR2000 
pressure controller.  This method includes a set of common Signals 
and Data Channels that can be edited for a specific application. 

HYDROGEN.M Same configuration as the default method for MSD ChemStation 
control, but the 5975/77 instrument is set up to use the special 
hydrogen tune file, "HTUNE.U".  This tune file is created by running 
a "Full Hydrogen Tune" from the tune window. 

DEMO.M A demonstration method that uses "simulator" instruments to 
generate random signal data for purposes of testing, familiarization 
and demonstration. 

Method Files 
MS Sensor method files are “XML” formatted text files with the file extension “.mssmet”.  All settings 
(recipes) for the method components are contained within the method file. 

Method files are located in the MS Sensor “Method” folder: 

C:\Users\Public\Documents\Diablo MS Sensor 4.0\Methods 

You can view this folder by clicking, “Tools > Browse System Folders > MS Sensor Method Folder”. 

Opening Methods 
To open and edit a method, select the "Open Method" option of the "Method" menu (or the “Open 
Method” button on the Main Toolbar).  A window will be displayed, allowing you to select a method 
file from within the method folder.  The selected method will be loaded and displayed in the method 
editor window. 
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Creating New Methods 
New methods can be created by selecting "New Method" from the "Method" menu or by pressing 
the “New Method” button on the Main Toolbar.  You will first be presented with a window to specify 
the name of the new method.  You can either manually enter a new method name, or if you want to 
overwrite an existing method, you can select that method's name from the method list. 

 

After selecting the file name for the new method, the method editor browser window will be 
displayed with an empty method tree.  When creating a new method it is best to start from the top of 
the method tree by first adding the Instruments to the method, and then work your way down adding 
Signals, then Calculations (optional), and finally Data Channels.  It is also important to make sure 
that the Acquisition Settings are set correctly: 

 

Instruments 

 

Signals 

 

Calculations (Optional) 

 

Data Channels 

 

Acquisition Settings 

 
When you are finished creating your new method, make sure to save it before exiting the method 
editor. 
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Method Editor 

  

The Method Editor Window 

The method editor has two main panels.  The current method is displayed in a "tree" view in the left 
panel.  All method components (Instruments, Signals, Calculations, and Data Channels) that have 
been defined for the method are listed on separate lines under their respective section of the tree.  
For example all instruments that have been added to the method are listed under the "Instruments" 
section of the tree.  Each section of the tree can be expanded or collapsed by clicking on the +/- 
symbol to its left.  You can view the settings for a particular component by selecting it in the tree.  
The current settings will be displayed in a table in the right panel of the editor. 

Component Key Names 

Each component in a method is assigned a unique "key name" when it is first added to a method.  
The key name begins with the component prefix identified in the table below.  Each key then has a 
unique integer appended to it (e.g. Inst1, Inst2, Sig1, Sig2) so that the component can be uniquely 
identified.  These key names are important because they are used to identify the component in 
Calculation and Data Channel formulas. 

 

Component Key Name Prefix 

Instrument Inst 

Signal Sig 

Calculation Calc 

Data Channel Chan 
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Editing Components 

In general, the various method components can be edited by right-clicking on the desired item in 
the tree view on the left-hand side of the editing window, and then selecting the desired action 
(new, edit, delete) from the resulting pop-up menu. 

Method Editor Toolbar 

The following functions are available in the Method Editor Toolbar: 

 

 

Button Description 

New Create a new method. 

Open Open a method file. 

Save Save the current method. 

Save As Save the current method to a new method file. 

Method Settings Edit the method settings (method description and data folder). 

Add Instrument Add a new instrument to the method. 

Add Signal Add a new signal to the method. 

Add Calculation Add a new calculated component to the method. 

Add Channel Add a new data channel to the method. 

Acq Settings Edit the acquisition (run) settings. 

Adding New Components to a Method 

To add a new component (Instrument, Signal Calculation or Channel) to a method you can either 
use the appropriate menu option under the "Edit" menu of the method editor, or you can right-click 
on the appropriate section of the tree and select the "Add" option from the resulting pop-up menu.  
For instance, to add a new instrument to the method, you can either select "Add Instrument" from 
the "Edit" menu, or you can right click on the "Instruments" section of the tree and select "New 
Instrument" from the pop-up menu. 

Editing Components 

To edit the settings for an existing component, you should first expand that component's section of 
the tree, and then double-click the component's line in the tree.  For example to edit the settings for 
Instrument 1, you would expand the Instruments section of the method tree and then double click 
the line that starts with "Inst1:" 

You can also edit a component by selecting it in the tree view, and then double-clicking anywhere in 
the table displaying the component's parameters on the right panel of the method editor. 
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Deleting Components from a Method 

A component can be deleted from the method by right clicking the component in the method tree 
and then selecting the "Delete" option form the pop-up menu. 

IMPORTANT: Be very careful deleting components from a method.  When you delete a particular 
component, any other component that uses it in a formula will also be deleted automatically to 
prevent invalid formulas in the method. 

Editing Acquisition Settings 

The acquisition (run) settings can be edited by double-clicking on the "Acquisition Settings" line of 
the method tree.  You can also right-click on the "Acquisition Settings" line of the method tree and 
then select "Edit Acquisition Settings" from the resulting pop-up menu.\ 

Method Components 
The following sections describe the method Instrument, Signal, Calculation, and Data Channel 
editing windows in detail. 

Instruments 

When a new instrument is added to a method, the following window is displayed. 

 

Add New Instrument Window 

Instrument Description 

Enter a description for this instrument.  The instrument description is displayed in the method tree to 
help you identify the instrument. 

Select Instrument 

Instruments supported by the MS Sensor software are listed in the "Select Instrument" list box.  A 
specific instrument driver has been written for each instrument that is listed.  Once you have 
selected the desired instrument type and press the "Add" button, an instrument-specific “Edit 
Recipe” window will be displayed that allows you to configure that instrument.  For more information 
on the supported instruments and their configuration, see “Instruments” on page 69. 
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Instrument Settings 

Each instrument has its own custom window that is used to define the instrument's settings for 
acquisition.  Please refer to the specific Instrument in the "Instrument" section for information on 
configuring a particular instrument. 

Signals 

Signals are numeric values that are the foundation of an MS Sensor method.  The signal recipe 
defines what result will be retrieved from a particular instrument's raw signal data. 

 

Edit Signal Window 

Signal Description 

Enter a description of the Signal.  This description will appear in the method tree to help identify the 
Signal. 

Instrument 

The Instrument list box will contain the description of each instrument that has been added to the 
method.  Select the instrument from which you want to retrieve a Signal.  Once you have selected 
an instrument, the "Signal Type" and "Signal Index" sections of the window will be updated to reflect 
the types of signals that are available for the selected instrument. 

Signal Type 

Each instrument can support multiple types of signals.  All signals provided by the selected 
instrument are listed in the "Signal Type" list box.  Depending on the type of signal, an additional 
Signal Index may also be required to define the signal fully.  The signal types that are provided by 
each instrument are described in the Instruments section. 

Signal Index Values 

The signal types available for an instrument can be one dimensional, like a simple pressure signal, 
or multi-dimensional, like a mass spectrum.  Multi-dimensional signal types require additional signal 
index values in order to be able to retrieve the proper value.  If a signal index value is required for 
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the selected signal type, then one or both of the signal index text boxes will be enabled and a 
descriptive label for the index will be displayed. 

For example, the MS Simulator instrument provides the "Mass Spectrum Abundance" signal type.  
This signal type requires one index value that is labeled "M/Z".  This signal index happens to be the 
mass-to-charge ratio whose abundance will be extracted from the current mass spectrum when the 
signal is processed during a run. 

Apply Pressure Compensation to Calibrated Response 

If pressure compensation is enabled in the method, and this checkbox is checked, then the 
calibrated response for this signal will also be corrected for the difference in pressure between the 
calibration and the results acquired during run. 

Create New Raw/Calibrated Data Channel 

This check box provides a shortcut if you want to create a new Data Channel from this Signal.  If 
you check the "Create New Raw Data Channel" option, the system will automatically create a new 
Data Channel based on the “raw” (uncalibrated) signal when you press the "Save" button.  Similarly, 
if you check the "Create New Calibrated Data Channel" option, the system will automatically create 
a new Data Channel based on the calibrated signal. 
 
This new Data Channel will have the same description as the Signal, and its formula will include 
only this Signal's raw or calibrated response.  See “Data Channels” on page 28 for more 
information. 

Please note that a new Data Channel will be created each time the "Save" button is pressed with 
this option checked. 

Calculations 

Calculations use a custom, user-defined formula to perform calculations in real time.  The formula 
can include Signal values (both raw and calibrated) as well as constants, mathematical operators, 
and a number of mathematical functions. 

 

Edit Calculation Window 



Methods 

26 MS Sensor 4.0 Reference Manual 

Description 

A string that describes this Calculation:  this description will appear in the method tree to help 
identify the Calculation. 

Formula 

This field displays the formula that is currently defined for the component.  In order to edit the 
formula, you must open the Formula Editor by pressing the "Edit Formula" button. 

Create New Data Channel 

This check box provides a shortcut if you want to create a new Data Channel from this Calculation.  
If you check the "Create New Data Channel" option, the system will automatically create a new 
Data Channel based on this Calculation when you press the "Save" button.  This new Data Channel 
will have the same description as the Calculation, and its formula will include only this Calculation's 
response.  See the “Data Channels” on page 28 for more information. 

Please note that a new Data Channel will be created each time the "Save" button is pressed with 
this option checked. 

Formula Editor 

Formulas are used by Calculations and Data Channels to define their value.  A formula editor is 
provided to help create the desired formulas.  A formula consists of Component key names, 
constants, and mathematical operators.  The formula editor can be displayed from either the Edit 
Calculation or Edit Data Channel window by pressing the "Edit Formula" button. 
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Formula Editor Window 

Components 

This list includes all of the components (Signals, Calculations, and Channels) that are available in 
the current method.  If you are editing a Calculation formula then only the Signal Components will 
be present in the list.  If you are editing a Data Channel formula, then both Signals and Calculations 
will be present in the list. 

Components are represented in a formula by their key name enclosed in curly braces.  To add a 
component to the formula simply double click on the component in the list.  The component key 
name will be added to the formula at the last location of the cursor in the formula. 

Alternatively, you can also drag and drop a component from the tree to the desired location in the 
formula.  The corresponding component “key” will be inserted at the location it is dropped. 

Signal Types 

When you add a Signal to the formula, you will be presented with the following window to select the 
signal type that should be placed in the formula. 
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Select Signal Type Window 

Calibrated Signal Response:  The signal response after the calibration function has been applied.  
The "Cal" signal type will be appended to the key name in the formula (e.g. "Sig1.Cal"). 

Raw Signal Response:  The raw signal response before the calibration function has been applied.  
The "Raw" signal type will be appended to the key name in the formula (e.g. "Sig1.Raw"). 

Calibration Slope:  The slope from the calibration function for this Signal.  The "Slope" signal type 
will be appended to the key name in the formula (e.g. "Sig1.Slope"). 

Calibration Intercept:  The intercept from the calibration function for this Signal.  The "Intercept" 
signal type will be appended to the key name in the formula (e.g. "Sig1.Intercept"). 

Operators 

The mathematical operators that are supported in formulas are listed here.  In addition, commonly 
used operators are assigned to the buttons.  To place an operator in the formula, you can either 
double click on it in the Operators list, or you can click the appropriate button.  The operator will be 
placed at the last cursor location in the formula. 

Constant 

Numeric constants are entered into the formula manually. 

Current Formula 

The current formula is displayed in this text box. 

Check Button 

Use this button to check whether the current formula is valid.  The formula editor will not let you 
save an invalid formula. 

Undo Button 

This button will undo the changes made to the formula. 

Data Channels 

Data Channels are the top-level components that are trend plotted, displayed in real time, etc.  Data 
Channels are defined by a custom formula that can include both Signals and Calculations. 
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Data Channel Editor Window 

Description 

The description is text that describes the Data Channel.  This description will appear in the method 
tree to help identify the Data Channel.  In addition, the description will also appear in the legend of 
the trend plot, and as the column header in both the real-time trend data grid and in the data files. 

Formula 

This field displays the formula that is currently defined for the Data Channel.  In order to edit the 
formula, you must open the Formula Editor by clicking the "Edit Formula" button. 

Calculation Mode 

The following calculation “modes” can be selected to determine how the data channel response is 
calculated. 
 

Calculation Mode Description 

Current Value The current value of the formula. 

Average of Consecutive Results The average of each set of “n” consecutive 
values.  The channel response will only be 
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updated after each set of “n” values has been 
acquired, calculated, and averaged. 

Moving Average of Consecutive Results The moving average of the last “n” consecutive 
values. 

 

Display Settings 

The following display options can be set for each Data Channel. 

 

Data Channel Display Settings Window 

Display in Data Grid:  If this checkbox is selected, then this Data Channel will be included in the 
real-time data grid during acquisition.  This setting has no effect on whether this Data Channel is 
saved to the data file. 

Display Format:  A format string can be entered to define how the Data Channel's value is 
displayed in the real-time data grid.  This setting only affects the display in the real-time data grid.  It 
does not affect the format of the value that is saved to the data file.  See “Example Format Strings” 
on page 31. 

Trend Plot Line Color:  You can select the color of the line that will be plotted for this channel. 

Display in Trend Plots:  Data Channels can be assigned to one or more of 6 trend-plot windows.  
This can be advantageous if you want to place unrelated Data Channels in different windows or you 
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want to group channels with similar response ranges together.  If this checkbox is selected, then 
this Data Channel will be displayed in the selected trend-plot window. 

Note: You can also rename the title of each of the six trend plot windows 

Example Format Strings 

The following table presents some commonly-used format strings. 
 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to the 
right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits to the 
right of the decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 digits 
to the right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 

The value 232 will be displayed as 232.0 

Acquisition Settings 
The Acquisition Settings control the display and saving of data during acquisition. 
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The Edit Acquisition Settings window 

Run Timing 

 

Run Timing tab of the Acquisition Settings window 

Acquisition Interval 

The acquisition interval controls the frequency that the system will process the Signals, Calculations 
and Data Channels and update the real-time trend plots and data grid and data files.  In order to 
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preserve system resources during long runs, it is best to set this value to the longest interval that 
still allows process features to be resolved adequately. 

IMPORTANT:  Some instruments, like the Agilent Technologies 5975/77 MSD, run asynchronously 
in the background.  Depending on the instrument parameters, those instruments may acquire 
signals at a rate that is either faster or slower than the Acquisition Interval.  When processing 
Signals, the last signal value acquired by the instrument is always used.  This means that if the 
instrument is acquiring data at a slower rate than the Acquisition Interval, duplicate results may be 
processed and displayed.  Conversely, if the instrument is acquiring data at a faster rate than the 
Acquisition Interval, then some data may be skipped. 

Run Length 

The length of the run in minutes.  The system will automatically end the run at this run time.  If a run 
length of 0 is specified, the acquisition will run continuously until it is stopped by the user. 

Data Files 

 

Data Files tab of the Acquisition Settings window 

This tab allows you to select which results will be saved to the data file during a run.  Signal results 
must be saved for calibration runs.  Data Channel results should be saved unless you don’t need to 
review or retrieve the results after the run (for example, you are using the Modbus Slave Server to 
transfer results to a process control computer). 

Export selected results to MS Sensor 3.0 CSV Files 

If this option is checked, then MS Sensor 3.0 CSV text files will be created for the selected results in 
the data file folder automatically at the end of the run. 

Note:  you can also create these text files at a later time by clicking “File > Export Results to Text 
File”.  See “MS Sensor Text Files” on page 66 
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Data Table 

 

Data Table tab of the Acquisition Settings window 

Display real-time data channel grid window 

If this box is checked, a data grid will be displayed during acquisition.  The data grid contains the 
actual Data Channel response values. 

Scroll Window 

In order to preserve system resources during long runs, the data grid is designed to "scroll": as new 
results are acquired, the oldest results are removed from the table.  This setting allows you to set 
how long results will be kept before they are removed from the table. 
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Trend Plot 

 

Trend Plot tab of the Acquisition Settings window 

Display real-time trend plot windows 

If this box is checked, from 1-6 real-time trend plots will be displayed during acquisition.  Data 
Channels are assigned to a particular trend plot window in the Data Channel settings window. 

Scroll Window 

In order to preserve system resources during long runs, the trend plots are designed to "scroll": as 
new results are acquired, the oldest results are removed from the plot.  This parameter allows you 
to set how long results will be kept before they are removed from the plot. 

Run-Time (X) Axis Label 

The label that will be displayed below the run time (X) axis on all trend plot windows.  Leave this 
blank if you don’t require the label and want to free up more space for the plot window. 

Trend Plot Titles 

You can modify the title and the response (Y) axis label of each of the six trend plot windows. 

Import MS Sensor 3.0 Methods 
To import an MS Sensor 3.0 method and convert it to an MS Sensor 4.0 Method, click the main 
menu option, “Method > Import > MS Sensor 3.0 Method”.  Browse and select the desired MS 
Sensor 3.0 method to import. 
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Note:  MS Sensor 3.0 methods are actually folders with a “.M” extension.  By default MS Sensor 3.0 
Methods are located in the folder: 

C:\MSSensor\Methods 

During import, the MS Sensor 3.0 methods will be converted to the MS Sensor 4.0 single file XML 
format and will be saved to the default MS Sensor 4.0 method folder: 

C:\Users\Public\Documents\Diablo MS Sensor 4.0\Methods 

MS Sensor 4.0 methods have a file extension of “.mssmet”. 

Important Considerations: 

1. After importing the MS Sensor 3.0 method you should carefully review the new MS Sensor 
4.0 method in the method editor to make sure the conversion worked as expected. 

2. Depending on the nature of your MS Sensor 3.0 method, it may actually be better to create 
a new MS Sensor 4.0 method from scratch in order to take advantage of some of the new 
capabilities of MS Sensor 4.0.  For example, in MS Sensor 3.0, pressure compensation was 
often handled using a set of Calculations, while in MS Sensor 4.0 it is built into the 
calibration functionality. 

3. In MS Sensor 3.0 the Pressure Simulator functionality was incorporated into the PDR 2000 
instrument driver.  In MS Sensor 4.0 there is a separate Pressure Simulator instrument.  
When importing the method, if there is a PDR 2000 instrument with “Simulation Mode” 
enabled, the Pressure Simulator instrument will be added to the new method.  If Simulation 
Mode is not enabled, then the PDR 2000 instrument will be added to the method. 

4. Currently MS Sensor 4.0 only supports mass spectrometers that are controlled by the 
Agilent MassHunter GC/MS data system.  Instruments that are controlled by the older MSD 
ChemStation software will need to be upgraded to MassHunter before they can be used with 
MS Sensor 4.0. 

Import Application from Application Builder 
The MS Sensor Application Builder software is tool to help users develop direct sampling mass 
spectrometry applications where spectral interference must be considered (like applications for the 
Diablo 5000A Real-Time Gas Analyzer).  The Application Builder software uses the NIST Mass 
Spectral Library of 267,376 chemical compounds and the user's estimate of compound 
concentration to generate a combined sample spectrum and a table of sample m/z values with 
estimates of potential interference.  See the Application Builder reference manual for more 
information about the software and its capabilities. 

Application files generated by the Application Builder software contain a list of compounds and the 
“best” m/z value to use for the specified application.  MS Sensor 4.0 can import that list of 
compounds and convert it into a corresponding MS Sensor 4.0 method. 

You can export an application directly from the Application Builder software to the MS Sensor 
software by clicking the menu option, “File > Export Application to MS Sensor” (requires Application 
Builder version 4.0.2.3 or later).  MS Sensor 4.0 will be started if it isn’t already running, and the 
Application Data Import Wizard will be started using data from the current application. 

Alternatively, you can select an application file from within MS Sensor 4.0 by clicking the “Import” 
button in the main toolbar, or by clicking the main menu option, “Method > Import > Application 
Data” and selecting the desired application file. 
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Application Builder application files have a file extension of “.mssapp” and by default are located in 
the folder: 

C:\Users\Public\Documents\Diablo MS Sensor 4.0\Application Builder 

Application Data Import Wizard 

The Application Data Import Wizard helps you to create an MS Sensor 4.0 method from an 
Application Builder data file. 

 

When the Application Data Import Wizard starts, it will display the Application File, the Method File 
that will be created, and a summary of the compounds and corresponding m/z values that can be 
included in the method. 

Click the one of the “browse” button to change either the application data file or the method file 
name that will be created, and then click “Next” to proceed. 

Note:  By default the Method File will be named based on the application file name.  If a method by 
that name already exists in the method folder, then a numeric counter (“.1”, “.2”, etc.) is appended 
to the method file name so that the existing method isn’t overwritten. 
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Select (check) the compounds you want to include in the method and whether you want to 
compensate that compound for pressure, create a raw data channel, or create a calibrated data 
channel. 

Additional Signals: 

These special signals can also be added to the method. 

Total Ion Signal:  This signal represents the total ion signal that the electron multiplier detector is 
generating across the entire mass range (not just for the m/z values included in the method).  For 
best detector stability and lifetime, it is best to keep the total ion signal < 1,000,000 counts, with the 
best stability < 500,000 counts.  By including this signal in the method you can monitor this 
important parameter in real time. 

Sample Pressure:  The signal produced by a mass spectrometer at a particular m/z value is a result 
of both the chemical composition and the sample pressure.  By including the sample pressure in the 
method, the effects of sample pressure on the signal can be compensated to some extent. 
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This panel summarizes the Data Channels that will be created in the new method.  You can modify 
the Channel name, and specify one of 6 trend plot windows to plot each channel.  Both of these 
options can also be changed in the method editor once the method has been created. 
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On this panel you must select the instruments that will be added to the method.  The pressure 
sensor instrument will only be enabled if you have chosen to include a pressure signal. 
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In this final panel you can review the method that will be created.  Click the “Previous” button to 
make changes, or click “Create” to create the new method.  Once the method has been created, it 
will be opened in the method editor automatically for you to review. 
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Important: 

It is particularly important that you review the settings for each of the instruments included in the 
method to make sure that the instruments settings are correct.  For example: 

• If your Agilent MassHunter software is configured for more than one instrument, you need 
to make sure that the correct instrument is specified in the instrument settings. 

• If you have included the PDR 2000 pressure controller in your method, you need to make 
sure the PDR2000 instrument is using the correct serial port. 

Signal Calibration 
The MS sensor software allows multi-level external standard calibration of signals.  In addition, you 
can also correct for changes in sample pressure if you are acquiring sample pressure signal data. 

With external standard calibration, you introduce a calibration gas with known concentrations of the 
compounds of interest.  To calibrate the signal, you introduce the calibration gas and wait for the 
signal to stabilize.  You then calculate the raw signal response generated for each compound at the 
given concentration.  The calibration slope and intercept are then calculated and applied to sample 
signals as described in “Calibration Calculations” on page 46 below. 

You calibrate the signals in your method using the signal calibration window that is displayed by 
clicking the “Calibrate” button on the main toolbar, or by clicking “Calibrate Signals” option in the 
main “Method” menu.  If the Method Editor is open, you will need to close it in order to calibrate 
signals. 

See “Calibration Procedure” on page 48 below for step-by-step instructions for a typical calibration 
procedure. 

Calibration Best Practices 

• To the best of your ability, you should introduce the calibration gas through the same 
sample path and at a similar pressure as your sample gas. 

• It is usually best for the compound amounts in the calibration gas to be close to the 
expected amounts in your sample.  If you expect the concentrations to vary significantly 
during your experiment, you may need to consider performing a multi-level calibration with 
the calibration levels (amounts) encompassing the expected concentration ranges in your 
sample. 

• For the best accuracy, you should recalibrate after making changes to instrument or 
experimental settings that could change the instrument response.  For example, you should 
generally recalibrate after performing an auto-tune or hydrogen tune of the mass 
spectrometer. 
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Calibration Settings 

 

Calibration Levels 

Each Signal always includes one calibration level.  However, if you want to perform a multi-level 
calibration, you will need to add the additional levels by entering the desired total number of levels 
in this text box.  If you increase the number of levels in this setting, all signals will be updated to 
include this total number of calibration levels.  If you decrease the number of calibration levels, then 
any existing levels exceeding the new total will be deleted from all signals. 

Pressure Compensation 

If you want to incorporate pressure compensation into your calibration, then check “Enable pressure 
compensation of signal response”, and select the signal that contains the sample pressure.  See 
“Pressure Compensation” on page 47 and “Pressure Compensation with Multi-Level Calibrations” 
on page 47 below for more information on pressure compensation. 
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Calibration Table 

 

The calibration table displays the amount, raw response, and calibration pressure for each of the 
signals in the selected Calibration Level. 

Amount 

You must enter the amount for each compound/signal in the calibration standard you want to 
calibrate at this level. 

Raw Response 

This is the raw signal response that will be used to calibrate the signal for the specified amount at 
the specified level.  You can either enter the raw response manually, or you can retrieve it from a 
data file containing signal data from a calibration run using the “Load Data File” and “Get 
Response” buttons below. 

Force Origin 

If this option is enabled and there are three or more calibration levels defined, then the linear 
regression will be forced through the origin (0,0).  This option should be used carefully since it can 
bias the calibration.  However, it can be a helpful tool to have under certain circumstances. 
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Load Data File 

Click “Load Data File” to load the signal data from a calibration run.  Then select (check) the signals 
that you want to calibrate at this level using signal data from this data file.  Each of the selected 
signals will be displayed in the plot.  Zoom into the desired range of the plot that you want to use as 
the raw response for the calibration. 

Zooming 

To zoom in on a section of the plot, place the mouse cursor at the upper left corner of the desired 
zoom range, and then click and hold the left mouse button while you drag the cursor to the lower 
right corner of the desired region.  When you release the mouse button, the plot will display the new 
zoom region. 

To zoom out, you can either double-click anywhere on the plot or click and drag a zoom window 
from the lower right to the upper left. 

Important Notes: 

1) You must enable saving of Signal data in the Acquisition Settings before collecting the 
calibration data. 

2) You should make sure that the data file you use for calibration was collected using the same 
method you are calibrating.  If the method name from the data file does not match the 
method you are calibrating, a warning will be displayed. 

Get Response 

When you click the “Get Response” button, the average signal response will be calculated for each 
of the selected signals over the range displayed in the plot window.  Those average signal response 
values will then be transferred to the “Raw Response” column in the calibration table.  If you have 
enabled pressure compensation in the Calibration Settings, then the average sample pressure over 
that same range will be calculated and transferred to the “Pressure” column in the calibration table. 

Calibrate 

Once you have entered the Amount, Raw Response, and Sample Pressure for the selected signals 
at all the calibration levels, click the “Calibrate” button.  The calibration slope and intercept (if 
appropriate) will be calculated for each of the selected signals and the Calibration Results tab will 
be displayed automatically. 
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Calibration Results 

 

Calibration Levels 

The “Calibration Levels” table displays the calibration data for all levels used to calculate the 
calibration slope and intercept for the specified signal. 

Calibration Results 

The “Calibration Results” table displays the calibration slope and intercept calculated for the 
specified signal.  If the calibration includes three or more levels and a linear regression was used to 
determine the calibration slope and intercept, then the Standard Error and R^2 values for the 
regression are also displayed.  See “Calibration Calculations” on page 46 below for more 
information on how the calibration slope and intercept are calculated.  In addition, see “Pressure 
Compensation” on page 47 and “Pressure Compensation with Multi-Level Calibrations” on page 47 
below for information on how pressure compensation is integrated into the calibration. 

Calibration Plot 

The Calibration Plot is a plot of the Amount vs Corrected Response for the specified signal.  The 
line displayed is calculated from the calibration slope and intercept. 

Calibration Calculations 

The calibrated signal response for a compound in a sample is calculated using the equation below: 

Calibrated Amount = (Corrected Signal Response – Calibration Intercept) / Calibration Slope 
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Where “Corrected Signal Response” is the raw signal amount that has been corrected for 
differences in sample pressure between the calibration and the current value (See “Pressure 
Compensation” below).  The Calibration Slope and Intercept are calculated differently depending on 
whether you have one, two, or three or more calibration levels as described below. 

One Calibration Level 

Calibration Slope = Corrected Signal Response / Amount 

Calibration Intercept = 0 

Two Calibration Levels 

Calibration Slope = (Corrected Signal Response(1) – Corrected Signal Response(0)) / (Amount(1) - 
Amount(0)) 

Calibration Intercept = Corrected Signal Response(0) – Calibration Slope * Amount(0) 

Three or More Calibration Levels 

Calibration Slope = Slope of the linear regression 

Calibration Intercept = Intercept of the linear regression 

Three or More Calibration Levels with Force Origin 

Calibration Slope = Slope of the linear regression with intercept forced through origin 

Calibration Intercept = 0 

Pressure Compensation 

The signal produced by a mass spectrometer at a particular m/z value is a result of both the 
chemical composition and the sample pressure.  Over moderate pressure ranges we can assume 
that the change in MS response is linear with changes in sample pressure.  By recording the 
pressure during calibration, you can correct the signal response for a change in sample pressure 
using a simple ratio: 

Corrected Signal Response = Raw Signal Response * Calibration Pressure / Current Pressure 

Pressure Compensation with Multi-Level Calibrations 

Since gas viscosity and vacuum pumping efficiency can change with gas composition, it is not 
unusual to see changes in sample pressure when measuring different calibration gas standards. 
Consequently, when you are performing a multi-level calibration, there is a separate sample 
pressure associated with the measurement of each set of calibration gas standards used.  The MS 
Sensor software provides two ways to account for these differences in sample pressure between 
different calibration levels: 

1) Use the average sample pressure from all calibration levels. 

2) Correct the signal response from the different levels so they are all based on the pressure of 
the first calibration level: 
 
Corrected Response (Level 2) = Raw Response (Level 2) * Pressure (Level 1) / Pressure 
(Level 2) 
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To use the recommended approach (option 2), check the “Correct multi-level calibration signal 
response for pressure” option in the Pressure Compensation section of the Calibration Settings.  If 
this checkbox is unchecked, then the average pressure (option 1) will be used. 

 

Calibration Procedure 

IMPROTANT:   

• Open the method you will be calibrating and make sure you have created the desired 
signals for the components you want to calibrate.  It is a good idea to create “raw” data 
channels for each of those signals. 

•   Also, Make sure you have enabled saving of Signal data in the Acquisition Settings. 

The general approach to signal calibration is as follows: 

1) Open the Signal Calibration window by clicking the “Calibrate” button on the main MS 
Sensor toolbar. 

2) On the “Calibration Settings” tab, specify the number of calibration levels, and whether to 
correct the signal response for pressure: 
 

 
 

3) Switch to the “Calibration Table” tab, and select (check) the signals that are present in the 
calibration gas, and enter the concentration of each signal. 
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4) Start the calibration run and introduce the calibration gas.  When the signals have stabilized, 
click “Load Data File” and select the desired calibration data file. 

5) Zoom into the section of the signal plot that you want to use to calibrate the signal response. 
 

 

6) Then click “Get Response”.  The average signal response over the zoomed range for each 
selected component will be calculated and transferred to the calibration table as the “Raw 
Response”.  If you enabled pressure compensation, the average sample pressure over the 
zoomed range will also be calculated and transferred to the calibration table. 
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7) Repeat steps 3-6 until you have obtained the signal response values for all the desired 
signals in all the calibration levels. 

8) Click the “Calibrate” button.  The calibration slope and intercept (if appropriate) will be 
calculated for each of the selected signals.  The Calibration Results will be displayed 
automatically. 
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9) If the calibration is acceptable, then click the “Save” button and the current calibration will be 
saved to the method.  When you make subsequent runs, the calibrated signal response will 
reflect this new calibration. 
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Acquisition 

Acquisition Control Panel 
The acquisition of process data is controlled using the Acquisition Control Panel.  To display the 
control panel, click the “Acquire” button on the main toolbar. 

 

The MS Sensor Manual Acquisition Control Panel 

The Acquisition Control Panel includes a toolbar to control the run, Run Status, and Run Time 
panels, and an instrument table displaying the status of the individual instruments in the method. 

Acquisition Toolbar 

 

 

Button Description 

Data File Select the data file to be used for the acquisition. 

Initialize Initialize the instruments and bring them to the “Ready” status.  You will be 
prompted to specify a data file, and optional sample name, operator name, 
and additional sample information. 
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Start Run Start acquiring and processing data from all instruments 

Pause Run Temporarily pause acquisition.  Data will not be collected while the run is 
paused.  However, the run time will continue to update. 

Stop Run Stop acquiring data from the instruments and perform any post-run actions. 

Exit Close the Acquisition Control Panel.  Instruments must first be shut down by 
clicking “Stop Run”.  If the system is acquiring data, you must stop the run 
before exiting. 

Help Display help. 

Sample Information Window 

When you initialize a run, you will first be prompted to enter a data file name and optional sample 
information: 

 

Data File 

The MS Sensor data file is actually a folder with “.D” appended to the name.  This folder contains 
the actual data file (.mssdata) the Agilent MS raw data file (data.ms) as well as other files required 
for the run.  You can enter the data file name manually (the “.D” will be appended automatically), or 
you can click the browse button to display a file browser: 
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Sample Information 

Entering the Sample Name, User, and Sample Description is optional.  If you do enter this 
information, it will be saved to the data file, and included in the text files that are exported from the 
data file. 

Instrument Status Table 

The Instrument Status Table contains a list of all instruments in the method and their current status. 

 

The instrument status text and colors are summarized below. 
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Status Color Description 

Offline White The method has been loaded, but communication has not yet been 
established with the instrument. 

Online Gray The instrument has been initialized and communication has been 
established between the MS Sensor software and the instrument. 

Pre-run Yellow The instrument is loading parameters and performing any required 
pre-run actions. 

Ready Green The instrument is ready to begin the run 

Acquiring Blue The instrument is acquiring data. 

Paused Gray The instrument is currently paused. 

Post-run Yellow The instrument is performing any post-run actions that are required. 

Finished Gray The instrument has finished acquisition and is back in Online mode. 

Error Red An instrument error has occurred.  Check the event log to see a 
description of the error. 

Trend Plot Window 
The MS Sensor software provides up to six windows to trend plot Data Channel response in real 
time.  By default, the trend plot Y-axis (response) will scale automatically when new points are 
added to the plot so that they are visible.  The X axis (run time, in minutes) scrolls automatically as 
new points are added to the plot. 

 

MS Sensor Real-time Trend Plot Window 

Trend Plot Toolbar 

Each trend plot window has its own toolbar that provides functions to customize the behavior of that 
window. 
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Button Description 

Print Trend Plot Display a window that allows the current trend plot to be printed. 

Copy to Clipboard Copies the current trend plot to the Windows clipboard. 

Trend Plot Settings Displays the trend plot settings window allowing you to change 
the plot title, assign data channels to be plotted in the window, 
and set the data channel line colors. 

Zoom X Axis Full Scale Zooms the X-axis of the selected trend plot to the min/max of the 
full run-time range. 

Zoom Y Axis Full Scale Zooms the Y-axis of the selected trend plot to the min/max over 
the displayed run-time range. 

Zoom X&Y Axes Full Scale Zooms both the X (run time) and Y (response) axes of the 
selected trend plot to the min/max over the full range of data. 

Set Min/Max Displays a window that allows the minimum and maximum of the 
X (run time) and Y (response) axes of the selected trend plot to 
be set manually. 

Sync Run Time All trend plot windows that have this button selected will 
synchronize their run-time axis.  

Autoscale Y Axis If this button is selected, then the trend plot’s Y (response) axis 
will automatically scale to include the maximum and minimum 
data points within the current time window. 

Autoscale X Axis If this button is selected, then the trend plot’s X (run time) axis 
will automatically scale to include the maximum and minimum 
data points within the current time window. 

Scroll Window 

In order to preserve system resources during long runs, trend plots are designed to "scroll": as new 
results are acquired, the oldest results are removed from the plot.  See “Trend Plot” on page 35 
information on how to set the length of the scroll window. 

Zooming In and Out of the Trend Plot 

To zoom in on a section of the plot, place the mouse cursor at the upper left corner of the desired 
zoom range, and then click and hold the left mouse button while you drag the cursor to the lower 
right corner of the desired region.  When you release the mouse button, the plot will display the new 
zoom region. 

Please note that if you zoom during a run, by default both the X- and Y-axis will automatically re-
scale to include any new points that are added outside the current zoomed range.  This behavior 
can be disabled by un-selecting the “Autoscale” buttons in the trend plot toolbar. 
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Setting the Trend Plot Axis Scale 

In addition to zooming and dragging the plots, the axis scales can also be set manually by clicking 
the “Set Min/Max” button in the toolbar.  The following window will be displayed, allowing the 
minimum and maximum values of both the X (Run Time) and Y (Response) axes to be set. 

 

When the window is first displayed, the min and max values are initialized to the current values from 
the selected trend plot.  You can click the associated buttons to reset the response minimum and 
maximum values to the current values. 

Note that the plot shown in this window does not represent actual data. 

Repositioning the Trend Plot 

It is possible to reposition the graphing region of the trend plot inside the axis lines by pointing the 
cursor to this region and then clicking and holding the right mouse button.  The graph can then be 
dragged to a new position.  The scale of the axes will be changed automatically to reflect the new 
position. 

Trend Plot Settings 

The Trend Plot Settings window allows you to change the plot title, assign data channels to be 
plotted in the window, and set the data channel line colors. 
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To change the trend line color of a particular channel, select the corresponding cell in the Line Color 
column, and then click the […] button that is displayed on the right side of the cell. 

 

Note:  If you change the trend line color for a particular channel, it will be reflected in any other 
trend plot windows that are displaying that same channel. 

Displaying Trend Plot Windows 

By default, only trend plot windows that have data channels assigned to them in the method will be 
displayed when the acquisition is initialized.  However, you can enable the display of other hidden 
trend plot windows using by checking them in the “Window > Display Trend Plot Windows” menu: 
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Once a hidden window is displayed, you can use the Trend Plot Settings window to assign data 
channels to it. 

You can also use this menu to hide plot windows by unchecking them.  Note that while a trend plot 
window is hidden, it will not be updated with data.  In addition if you hide and then re-display a trend 
plot window, it will only show data updated after it was re-displayed. 

Real-time Data Grid 
The real-time data grid shows the actual Data Channel response values as they are acquired in real 
time.  The numeric format of the response values displayed in the grid can be set using the "Format 
String" setting in the Data Channel editor (see “Display Settings” on page 30).  In addition, the 
number of lines of data that are displayed in the data grid is determined by the Data Grid's "Scroll 
Window" setting in the Method's Acquisition Settings (see “Scroll Window” on page 34). 

 

MS Sensor Real-time Data Grid 
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Data Analysis 

Overview of Data Analysis 
The MS Sensor software is designed primarily as a data acquisition and real-time trend-plotting 
package for process analysis.  In addition, since post-run data analysis requirements vary widely, it 
is difficult to design an acceptable "one-size fits all" data analysis solution.  Consequently, we have 
chosen to provide the results in a delimited text file format that can be imported easily into third-
party spreadsheet, statistical analysis, and modeling packages. 

However, we also recognize that it is important to be able to review results before more extensive 
data analysis.  With MS Sensor 4.0, we have introduced a new tool to help you with this data 
review:  the MS Sensor Data Viewer. 

MS Sensor Data Viewer 

 

The MS Sensor Data Viewer is a standalone program that allows you to evaluate MS Sensor 4.0 
data files prior to exporting results to your favorite spreadsheet or modeling program.  You can start 
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the Data Viewer either by clicking the “View Data” button in the main MS Sensor Toolbar, or by 
clicking the Data Viewer shortcut icon on the Windows desktop.  If you click the “View Data” button 
in MS Sensor during or after a run, the current data file will open automatically. 

Main Menu 

The Data Viewer main menu includes the following options: 

 

 

Menu Item Description 

Load Data File Load a MS Sensor 4.0 data file.  Note: you must select the “.mssdata” 
file inside the “.d” data file folder. 

Extract Method: Extract the embedded method from the current data file.  See “Extract 
Method” on page 66. 

Print Report: Print a Data Viewer report for the currently selected channels and trend 
plot.  See “Print or Save Report” on page 66. 

Save Report Save the data viewer report as a PDF file.  See “Print or Save Report” 
on page 66. 

Export Data Export the channel data to a comma- or tab-delimited text file.  See 
“Export Results” on page 66. 

Exit Exit the Data Viewer program. 

Main Toolbar 

The Data Viewer toolbar includes the following buttons: 

 

 

Button Description 

Load Data Load a MS Sensor 4.0 data file.  Note: you must select the “.mssdata” file 
inside the “.d” data file folder. 

Print Report Print a Data Viewer report for the currently selected channels and trend 
plot.  See “Print or Save Report” on page 66 
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Save Report Save the data viewer report as a PDF file.  See “Print or Save Report” on 
page 66. 

Export Data Export the channel data to a comma- or tab-delimited text file.  See “Export 
Results” on page 66 

Sample Information Table 

The sample information table displays information about the data file including the sample 
information entered when the file was created, the start and end run date and time, the run length 
and number of data points. 

 

You can select parts or all of the table and copy the selection to the clipboard by right-clicking the 
table and selecting “Copy Selection to the Clipboard” from the popup menu.  The selected sample 
information can then be pasted into a spreadsheet or document. 

Channels Table 

The channels table allows you to select which channels are displayed in the trend plot and 
summary results table.  Simply check or uncheck the desired channels.  If you double-click a 
channel, only that channel will be displayed.  If you right click the Channels table a popup menu will 
be displayed allowing you to Display the Selected Channel, Display All Channels, or Display No 
Channels. 
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Trend Plot Panel 

 

The Trend Plot Panel initially displays a plot of all currently selected channels over the full length of 
the run.  Summary results for each of the selected channels over the displayed range are shown in 
the summary results table (see “Summary Results Table” on page 65).  In addition, you can move 
the vertical cursor to different locations in the trend plot and view the results for that run time in the 
summary results table. 

Zooming 

To zoom in on a section of the plot, place the mouse cursor at the upper left corner of the desired 
zoom range, and then click and hold the left mouse button while you drag the cursor to the lower 
right corner of the desired region.  When you release the mouse button, the plot will display the new 
zoom region and the results summary table will be updated to reflect the new range. 

To zoom out, click the “Zoom Out” button in the toolbar, or the “Zoom Full Scale” button to view the 
entire plot again. 

Trend Plot Toolbar 

 

Normalize Channel Response 

If you click the “Normalized Channel Response” button, the selected plots will be rescaled so that 
the maximum value in each plot is normalized to 1000.  This can be helpful when evaluating data 
channels with widely differing response. 

Set Trend Plot Min/Max 

The trend plot axis scales can also be set manually by clicking the “Set Min/Max” button in the 
toolbar.  The following window will be displayed, allowing the minimum and maximum values of 
both the X (Run Time) and Y (Response) axes to be set. 
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When the window is first displayed, the min and max values are initialized to the current values from 
the trend plot.  You can click the associated buttons to reset the response minimum and maximum 
values to the current values. 

Note that the plot shown in this window does not represent actual data. 

Display Full Scale 

If you click “Zoom Full Scale”, the plot will be zoomed automatically to display the minimum and 
maximum values of the run time (X) axis and response (Y) axis. 

Zoom Back 

If you have zoomed into the plot multiple times, clicking the “Zoom Back” button will step you back 
to each previous zoom range. 

Summary Results Table 

 

The summary results table displays the Average, Minimum, Maximum, Standard Deviation, and 
%Relative Standard Deviation for each selected channel over the range displayed in the trend plot.  
It also displays the values that correspond to the current location of the vertical cursor bar in the plot 
window. 

You can select parts or all of the summary results table and copy the selection to the Windows 
clipboard by right-clicking the table and selecting “Copy Selection to the Clipboard” from the popup 
menu.  The selected results can then be pasted into a spreadsheet or document. 
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Export Results 

 

You can export the Data Channel results from the current data file to a delimited text file. 

Export Options – Channels 

Select whether to export the results from all channels in the data file, or only the selected/displayed 
channels 

Export Options – Range 

Select whether to export results over the entire run, or only the displayed range. 

Export Options – File Format 

Select whether to export the results as either a tab-delimited or comma-delimited text file. 

Print or Save Report 

The Data Viewer report displays the Sample Information table and trend plot on the first page, and 
the summary results table on subsequent pages.  Only the currently selected channels are included 
in the report.  You can either print the report to the default printer, or save the report as an Adobe 
Acrobat PDF file. 

Extract Method 

MS Sensor data files contain a copy of the original method that was used to acquire the data.  
Clicking the menu option, “File > Extract Method”, allows you to extract this embedded method and 
save it to the MS Sensor Method folder. 

MS Sensor Text Files 
The Signal, Calculation, and Data Channel process analysis results can be exported to comma 
delimited (CSV) text files automatically at the end of the run.  You can enable this export in the 
“Data Files” tab of the method “Acquisition Settings” (see “Data Files” on page 33). 

Alternatively, you can create these files at a later time by clicking, “File > Export Results to Text 
File”: 
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These files are saved in the data file directory that was specified at the start of the run.  These files 
are named as follows: 

Data Text File Name 

Signal Response Signals.csv 

Calculation Response Calculations.csv 

Data Channel Response Named based on the data file name.  For example if the data file 
name is "data1.d", then the Data Channel response will be 
exported to "data1.csv". 

Run Log Any events that are logged during the run are copied to the 
Events.csv file at the end of the run.  These events include 
system events as well as any user-log events. 

Each log file starts with a 4-line header: 

Line 1:  Operator name from the Sample Information window 

Line 2:  Sample Name from the Sample Information window 

Line 3:  Sample Description from the Sample Information window 

Line 4:  Comma-delimited column header line 

 

The process analysis results follow the header line immediately.  Each result line begins with the 
Date and Time and then the Run Time, in minutes, at which the result was acquired.  The response 
values for all components in the method follow as shown in the example below.  The Data Channel 
log file also includes a set of summary statistics, including the average, maximum, and minimum 
values for each component.  The summary statistics are placed at the end of the log file. 

Example Data Channel Text File 

Operator: SJH    

Sample Name: Random Simulator Data 
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Sample Description: No Sample    

Date Stamp Run Time Hydrogen Helium Methane 

4/25/01 15:40 3.32E-02 9259.05 3493.43 8357.51 

4/25/01 15:41 0.324467 9121.01 3437.10 8051.54 

 

Average:  9190.03 3465.27 8204.53 

Maximum:  9259.05 3493.43 8357.51 

Minimum:  9121.01 3437.10 8051.54 

Agilent Technologies MS Data File 
The Agilent Technologies MassHunter instrument advanced configuration dialog has an option to 
"Save Raw Spectral Data".  If you check this box, then the software will create an Agilent 
Technologies MSD ChemStation "data.ms" file in the “.D” data file directory that was specified at the 
start of the run.  This data file, which contains the raw mass spectral data for the run, can be loaded 
into the MSD ChemStation Data Analysis application, which allows sophisticated spectral 
manipulation, library searching, etc.  Please refer to the Agilent Technologies MSD ChemStation 
Data Analysis documentation for more information on its data analysis capabilities. 
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Instruments 

Instrument Overview 
The MS Sensor software uses a “plugin” interface architecture that allows data to be collected from 
several kinds of instruments.  A driver has been written for each supported instrument described 
below. 

Supported Instruments 

The following table lists the instruments that are currently provided with the MS Sensor software. 

Instrument Description 

MS Simulator A simple simulator that generates random abundance 
values over a specified "scan range". 

Pressure Simulator A simple simulator that generates random pressure 
values at a specified target pressure. 

Agilent MassHunter MSD Any Agilent Technologies Mass Selective Detector 
(MSD) using the MassHunter GC/MS Acquisition for 
control.  This instrument driver is required for the 5977 
MSD. 

MKS PDR2000 Pressure Controller Reads pressure data from an MKS PDR 2000 Pressure 
Controller using a serial interface. 

Diablo MPValve Sequencer This instrument driver interfaces with Diablo’s MPValve 
Sequencer to control VICI multiposition, stream-
selection valves. 

Diablo EZReporter Reads GC and GC/MS results exported from the Diablo 
EZReporter 4.0 reporting software. 

It is possible for other instruments to be added to the MS Sensor process analysis software via a 
custom driver developed by Diablo Analytical, Inc.  Please contact Diablo for more information. 

MS Simulator Instrument 
The MS Simulator instrument is a simple mass spectrometer simulator that generates simulated 
abundance values over a specified "scan range".  This instrument is used primarily for testing, 
training, and demonstration since it doesn't need to be connected to an actual instrument. 
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Configuring the MS Simulator Instrument 

 

Diablo MS Simulator Instrument Recipe Window 

Instrument Description 

This description is used to help identify the instrument in the method tree and the manual 
acquisition instrument status table. 

Scan Range 

Enter a Low (starting) mass and High (ending) mass to define the scan range over which the 
simulator will generate signal data. 

Simulated Sample Type 

You can choose the following simulated sample types: 

1) Random Dynamic Sample:  If you choose this sample type, then random values will be 
generated for each m/z value in the specified scan range.  The values will change with time, 
simulating a dynamic process. 

2) Simulated Air Sample:  This sample type simulates the spectrum produced by ambient air 
with a composition of 78% N2, 21% O2, 0.93% Ar, and 0.04% CO2.  The spectrum has a 
total abundance of 250,000 with ~5% random “noise”. 

Supported Signal Types 

When creating a signal based on the MS Simulator instrument, the following signal types are 
available. 
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Mass Abundance 

This signal type returns the abundance of the specified mass in the spectrum. 

Signal Index 1 (M/Z):  The mass-to-charge ratio of the desired peak in the mass spectrum.  This 
mass must fall within the scan range that is specified in the instrument parameters window. 

Total Ion Signal 

This signal type returns the total abundance of all ions in the mass spectrum. 

Base Peak Mass 

This signal type returns the mass of the largest peak in the mass spectrum. 

Base Peak Abundance 

This signal type returns the abundance of the largest peak in the mass spectrum. 

Pressure Simulator Instrument 
The Pressure Simulator instrument is a simple sample pressure simulator that generates random 
pressure values at a specified target pressure.  This instrument is used primarily for testing, 
training, and demonstration since it doesn't need to be connected to an actual instrument. 

Configure the Pressure Simulator Instrument 
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Diablo Pressure Simulator Instrument Recipe Window 

Instrument Description 

This description is used to help identify the instrument in the method tree and the manual 
acquisition instrument status table. 

Simulation Pressure 

The target simulation pressure. The instrument will generate random pressure values around this 
target pressure. 

Supported Signal Types 

When creating a signal based on the Pressure Simulator instrument, the following signal types are 
available. 

 

CH1 Pressure and CH2 Pressure 

The simulated pressure measured by a simulated transducer on Channel 1 or Channel 2. 

MKS PDR 2000 Pressure Controller 
The MKS PDR 2000 Pressure Controller is used to control the MKS Baratron Capacitance 
Manometer that is used to monitor the interface/sample pressure of the Diablo 5000A Real-Time 
Gas Analyzer differentially-pumped sampling system.  The pressure data is read using RS-232 
serial communication. 

Important:  The computer running the MS Sensor software must have one free RS-232 serial port 
available in order to read the pressure data from the PDR 2000. 

Configuring the PDR 2000 Instrument 

The MS Sensor instrument driver retrieves pressure data from the MKS PDR2000 Pressure 
controller using the RS-232 interface. 
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The MKS PDR2000 Configuration Window 

Instrument Description 

This description is used to help identify the instrument in the method tree and the manual 
acquisition instrument status table. 

Communication Parameters 

The PDR 2000 uses fixed RS-232 communication parameters, so the only communication 
parameter that needs to be set is the "Serial Port". 

Serial Port: 

The serial port on the MS Sensor computer to which the MKS PDR2000 controller is connected. 

Test Button 

Press this button to test whether communication can be established with MKS PDR2000 controller.  
If RS-232 serial communication is set up correctly, a window will be shown displaying the firmware 
revision of the PDR2000: 

 

Supported Signal Types 

When creating a signal based on the MKS PDR2000 instrument, the following signal types are 
available. 
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CH 1 Pressure 

The pressure measured by the transducer on Channel 1. 

CH 2 Pressure 

The Pressure measured by the transducer on Channel 2. 

Agilent MassHunter MSD 
The Agilent Technologies MassHunter GC/MS Acquisition software is required to control the 5977 
MSD and also currently supports the 5975 MSD.  

MassHunter Requirements 

The MS Sensor MassHunter MSD instrument driver requires the Agilent Technologies MassHunter 
GC/MS Acquisition software be installed and operational prior to installing the MS Sensor software.  
In addition, version B.07.05 or later of MassHunter is required.  Check the MS Sensor release notes 
for an updated list of compatible MassHunter versions. 

Important Note:  The Agilent MassHunter instrument control software must be closed before 
acquiring data from an MSD using the MS Sensor software. 
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Configuring the MassHunter Instrument 

 

Agilent MassHunter MSD Acquisition Parameters Window 

Instrument Description 

This description is used to help identify the instrument in the method tree and the instrument status 
table in the acquisition control panel. 

MassHunter Instrument 

Up to four instruments can be installed on an Agilent Technologies MassHunter computer.  Make 
sure to select the correct MSD instrument from the options that are provided. 

Acquisition Type 

MS Sensor 4.0 allows you to configure MassHunter for either single-scan or dual scan acquisition.  
With dual-scan acquisition enabled, MassHunter will alternate between two sets of acquisition 
settings, which can have different masses, tune files, and other detector settings (including 
SIM/Scan).  When you enable dual-scan acquisition, the “Select Scan Settings” list box allows you 
to switch between the two scans. 

Copy Settings 
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If you have configured MassHunter for dual-scan acquisition, you can copy the current settings from 
Scan 1 to Scan 2 to help you with the initial configuration of Scan 2. 

Tune File 

The MSD tune file that will be used by this method is listed in this panel.  By default, MS Sensor 
uses the "atune.u" file, which is the standard autotune file.  The "Select" button can be pressed to 
display a window that will allow you to specify a different tune file.  Additional information on tune 
files and tuning can be found in the "Tuning the MSD" section below. 

IMPORTANT:  If you create a new tune file in the Tune Window, make sure that you select that new 
tune file upon closing the Tune Window. 

Open Tune Window 

Clicking the "Open Tune Window" button causes the MassHunter Tune Window to open.  The Tune 
Window is used to initiate a pump down or vent of the MSD vacuum system, calibrate (tune) the 
MSD mass axis, and perform instrument diagnostics. 

Masses to Acquire 

The individual masses that you want to acquire can be entered into the masses table using the 
"Add" button.  Allowed values are 1.6 through 800.  Masses can be deleted from the table by 
clicking on their line in the table, and then pressing the "Delete" button. 

Default Instrument Settings 

This MassHunter instrument driver uses the following default instrument settings.  These default 
settings can be overridden using the Advanced Configuration dialog. 

 

Acquisition Mode Scan 

Scan Range With auto-scan range enabled, the scan range is set from 4 m/z 
below the lowest mass to 4 m/z above the highest mass 
specified in the "masses to acquire" table (this range is clipped 
so that it doesn't extend beyond the 1.6 to 800 m/z range). 

Samples 2^3 

Threshold 100 

MassHunter Acq Interval ~1 s. (fixed).  This is the interval at which mass spectra will be 
acquired from the MSD and saved to the “data.ms” file if the 
“Save raw mass spectral data” option is selected.  This setting 
is fixed at 1s and is independent of the overall acquisition 
interval set in the process monitoring parameters. 

EMV 0 volts Relative to the Tune voltage. 

Save Raw Spectra False 

Advanced MassHunter Configuration 

The Advanced Configuration dialog allows you to override the default instrument settings for the 
MSD. 
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Acquisition Mode 

The MSD can be configured to collect data in either full scan or Selected Ion Monitoring (SIM) 
mode.  This button allows you to choose which acquisition mode to use.  You typically choose Scan 
mode for general applications where you want to collect the full mass spectrum in case an unknown 
compound is present.  You typically choose Selected Ion Monitoring (SIM) mode when you need 
the highest sensitivity, or when you want to exclude large matrix ions from exposing the detector to 
high ion current. 

Save Raw Spectral Data 

If you check this box, the software will create an MSD ChemStation "data.ms" file in the “.D” data 
file directory that was specified at the start of the run.  This data file can then be loaded into the 
MSD ChemStation data analysis application, which allows sophisticated spectral manipulation, 
library searching, etc.  Please refer to the Agilent Technologies MSD ChemStation reference 
manuals for information on the data analysis capabilities of ChemStation Data Analysis. 

Important Note:  The raw spectral data will be saved to the ChemStation data file at a rate of 
approximately 1 spectrum/sec, regardless of the Acquisition Interval that is set in the method. 

Electron Multiplier Voltage 

The electron multiplier voltage to use for acquisition; this value can be either a positive or negative 
offset relative to the tune voltage or an absolute, positive voltage.  The resulting voltage must be in 
the range of 0-3000 Volts.  If the relative voltage results in the actual voltage exceeding 3000 volts, 
the system will automatically set the voltage to 3000 volts.  The default settings is 0 volts relative to 
the tune voltage. 
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Note:  You should make sure to keep the Total Ion Signal in an analysis below 1,000,000 counts 
(and below 500,000) for the best stability and detector lifetime.  If the Total Ion Signal is too high, 
you can enter a negative voltage offset in Relative mode to reduce the Total Ion Signal. 

Scan Parameters 

The following parameters must be set when the acquisition mode is set to "Scan". 

Override auto scan range 

By default, the software automatically sets the scan range based on the masses entered into the 
masses table.  If you would instead prefer to set the scan range manually, check the "Override auto 
scan range" checkbox and entered the desired starting and ending masses. 

Start Mass 

The starting mass of the scan range: allowed values are 1.6 through 800 m/z. 

End Mass 

The ending mass of the scan range: allowed values are 1.6 through 800 m/z.  The end mass must 
be greater than the start mass. 

Threshold 

This is the MS peak detection threshold.  Spectral peaks whose abundance is below this value will 
be ignored by the data system and their abundance will be set to 0.  If you are doing trace analysis 
with small peaks you should set the threshold to 0 so no peaks are lost. 

Samples 

A number n, where the number of samples is 2^n; allowed values for n are 2 through 7. This 
determines the degree of spectrum signal averaging that will be performed.  As you increase the 
number of samples, you will also decrease the raw spectrum acquisition rate. 

IMPORTANT :  Setting Samples to a value less than 3 can cause inconsistent results. 

SIM Parameters 

The following parameters must be set when the acquisition mode is set to "Selected Ion 
Monitoring". 

SIM Ion Table 

Up to 30 SIM ions can be added to the "Masses to Acquire" table on the main configuration window 
using the "Add" button.  Allowed values are 1.6 through 800 m/z.  Ions can be deleted from the 
table by clicking on their line in the table, and then pressing the "Delete" button.  See “Configuring 
the MassHunter Instrument” on page 75. 

Dwell Time 

The time in milliseconds for acquiring data at each mass: the acceptable range is 10-9999. The 
dwell time multiplied by the number of ions must be less than 59 s.  

Cycle Time 

The dwell time multiplied by the number of ions:  the total cycle time must be less than 59 s. 

Other Parameters 

Initialization Timeout 

The initialization timeout should be set longer than the time it takes for the MassHunter Acquisition 
window to start up and initialize.  Start with the default setting and increase it if you are experiencing 
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timeout errors during initialization that aren’t being caused by some other error.  The setting is in 
milliseconds. 

Shutdown Timeout 

The initialization timeout should be set longer than the time it takes for the MassHunter Acquisition 
window to shutdown and close.  Start with the default setting and increase it if you are experiencing 
timeout errors during shutdown that aren’t being caused by some other error.  The setting is in 
milliseconds. 

MassHunter Tune Window 

Pressing the “Tune Window” button opens the MSD Tune Window.  This window is a custom 
version of the MassHunter "Tune and Vacuum Control" window. 

The Tune Window is used to initiate a pump down or vent of the MSD vacuum system, to calibrate 
(tune) the MSD mass axis, and to perform instrument diagnostics. 

 

The MSD Tune and Diagnostic Window 

Tuning the MSD 

The following options located under the "Tune" menu are used to calibrate the mass axis of the 
MSD and set the relative response of the mass analyzer across the scan range.  Refer to the 
MassHunter GC/MS Acquisition reference manuals for more information on Autotune.  The 
following tune options are most commonly used with MS Sensor/RTGA applications. 
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Autotune (Atune.U) 

This is the standard autotune that uses PFTBA masses 69, 219, and 502 to tune the MSD across 
the full scan range of the instrument.  The results of the tune are automatically saved to the 
"atune.u" tune file. 

Low Mass Autotune (Lomass.U) 

This is a special, low mass range version of the autotune that uses PFTBA masses 69, 131, and 
219 to tune the MSD over the "light" end of the scan range.  The results of the tune are 
automatically saved to the "lomass.u" tune file.  This is likely the best tune for typical RTGA 
applications. 

Hydrogen Tune 

The measurement of very light ions like hydrogen with the MSD requires special tuning and 
hardware.  In order to perform a hydrogen tune, the MSD must have the special "Low Gauss" 
source magnet and a 6-mm drawout lens installed.  In addition, you will need to be able to supply 
the instrument with a "tune mix" containing 20-100% Hydrogen in a diluent gas like Helium or 
Nitrogen. 

 

There are two hydrogen tune menu options located under a separate "Hydrogen" menu, "Full 
Hydrogen Tune", and "Quick Hydrogen Tune".  The "Full Hydrogen Tune" automatically runs a Low 
Mass Autotune before optimizing the system for hydrogen response.  The "Quick Hydrogen Tune" 
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loads the current Low Mass Tune file (lomass.u) from disk, and then performs the hydrogen 
optimization tune using the Low Mass tune conditions as the starting point. 

The hydrogen optimization tune adjusts the repeller, ion focus, electron energy, emission current, 
and entrance lens offset parameters to produce maximum response at m/z=2.  In addition, masses 
69, 131, and 219 from the MSDs calibration fluid (PFTBA) are used to help calibrate the mass axis, 
adjust peak widths, and set the electron multiplier voltage so that a consistent signal abundance is 
achieved.   The results of the hydrogen optimization tune are save to the tune file 'htune.u'. 

IMPORTANT You should only perform the Hydrogen Tune with the standard 50-micron orifice 
plate installed on the high-vacuum side of the RTGA interface.  Hydrogen tuning is not compatible 
with the 350-um “high-sensitivity” orifice plate. 

Helium Tune 
The Helium tune is the same as the Hydrogen tune except it optimizes the response for helium at 
m/z=4.  You must provide a source of helium in order to perform a helium tune.  The helium tune is 
saved to the tune file “hetune.u”. 

Important Considerations 

There are several important things to consider when performing a hydrogen or helium tune. 

1. The system will be optimized for response in the very low mass range.  Consequently 
the performance at higher masses may be reduced. 

2. The hydrogen/helium tune will result in the Electron Energy being set to something other 
than the "standard" 70 eV.  This will only be an issue if calculations or library searches 
are performed with the assumption that the spectra will have a "classic" fragmentation 
pattern.  This is not expected to be important with standard uses of the Real-Time Gas 
Analyzer. 

3. Although the hydrogen/helium optimization tune will work over a range of concentrations, 
it is best to use a consistent tune mix in order to achieve reproducible and consistent 
hydrogen tunes for specific applications. 

4. After performing a hydrogen or helium tune, make sure that you specify 'htune.u' or 
‘hetune.u’ as the tune file in the MS Sensor "Agilent MassHunter MSD Acquisition 
Parameters" Window. 

Resetting to Factory Default Conditions 

The hydrogen and helium optimization tunes are influenced significantly by the starting conditions 
as defined by the low-mass autotune (lomass.u).   If for some reason the low-range autotune has 
drifted or become corrupted, it may be necessary to reset the tune parameters to their factory-
default values.   

The factory default tune files can be restored by running the Agilent GC/MS Configuration program.  
Open the instrument that corresponds to the RTGA MSD and then click “OK” to close and save the 
configuration.   



Instruments 

82 MS Sensor 4.0 Reference Manual 

 

Click “Yes” when prompted to “Proceed with update to Instrument Configuration” 

 

IMPORTANT:  After resetting the tune parameters to their default parameters, you should 
immediately run either a Low Mass Autotune, or a Full Hydrogen or HeliumTune so that the Low 
Mass autotune file is regenerated from the factory defaults. 

Data Acquisition with MassHunter 

When an MSD instrument is initialized, a MassHunter acquisition/scan window is automatically 
opened and minimized to the Windows taskbar.  This window can be restored during acquisition so 
that the mass spectrum of the process can be viewed in real time. 

Make sure not to close this window manually during acquisition, or the resulting instrument error will 
cause the analysis to abort immediately.  It is, however, safe to minimize this window during 
acquisition. 
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MassHunter Scan Window 

Supported Signal Types 

When creating a signal based on the Agilent MassHunter instrument, the following signal types are 
available. 

 

Mass Abundance 

This signal type returns the abundance of the specified mass in the spectrum. 

Signal Index 1 (Scan):  Allows you to choose whether the signal will be retrieved from Scan 1 or 
Scan 2 if you have enabled dual-scan acquisition. 
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Signal Index 2 (M/Z):  The mass-to-charge ratio of the desired peak in the mass spectrum.  This 
value must fall between the low mass and high mass scan range that is specified in the instrument 
parameters window. 

Total Ion Signal 

Signal Index 1 (Scan):  Allows you to choose whether the signal will be retrieved from Scan 1 or 
Scan 2 if you have enabled dual-scan acquisition. 

This signal type returns the total abundance of all ions in the mass spectrum. 

Base Peak Mass 

Signal Index 1 (Scan):  Allows you to choose whether the signal will be retrieved from Scan 1 or 
Scan 2 if you have enabled dual-scan acquisition. 

This signal type returns the mass of the largest peak in the mass spectrum. 

Base Peak Abundance 

Signal Index 1 (Scan):  Allows you to choose whether the signal will be retrieved from Scan 1 or 
Scan 2 if you have enabled dual-scan acquisition. 

This signal type returns the abundance of the largest peak in the mass spectrum. 

Diablo MPValve Sequencer 
This instrument driver is designed to interface the Diablo Analytical MPValve Sequencer application 
with the MS Sensor software to provide integrated control of VICI (Valco) multi-position, stream-
selection valves. 

With integrated valve control, the valve position can be specified as an MS Sensor Signal and Data 
Channel.  As a result, the valve position can be included with each line of data that is collected 
during acquisition. 

Important Note:  A fully functional evaluation copy of Diablo’s MPValve 3.0 software is included on 
the MS Sensor installation CD and the latest version of the software can be downloaded from 
Diablo’s web site.  You may evaluate MPValve Sequencer for 30 days.  After the evaluation period 
ends, you must purchase a software license from Diablo in order to continue using the software. 

Controlling the MS Sensor Run from MPValve Sequencer 

Important:  While it is possible to use the “Pause”, “Start”, and “Stop” buttons in MPValve 
Sequencer “Sequence Run Control” to control the MS Sensor run, it is preferable to control the run 
exclusively through the MS Sensor Acquisition Control Panel. 

If you do need to control the run through the MPValve Sequencer window, please be aware of the 
following issues: 

1) Clicking the MPValve Sequencer “Start” button will only start the MS Sensor run if the MS 
Sensor acquisition/run status is “Ready”. 

2) If you click the MPValve Sequencer “Pause” button, you must wait until the MS Sensor 
acquisition/run status is “Paused” before resuming the run by clicking “Pause” a second 
time.  If you resume the run before all MS Sensor instruments have paused, then some 
instruments may no longer be synchronized properly. 
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Configuring Diablo MPValve Sequencer 

 

MPValve Sequencer Configuration Window 

Instrument Description 

This description is used to help identify the instrument in the method tree and the manual 
acquisition instrument status table. 

Edit Sequence 

Press the “Edit Sequence” button to start the MPValve Sequencer software.  You can then either 
load an existing valve sequence file, or create and save a new valve sequence from within the 
MPValve Sequencer software.  See the MPValve software help file or manual for more information 
on setting up valve sequence programs. 

When a sequence file is opened or saved from within the MPValve Sequencer software, the 
sequence file will be passed automatically to the MPValve Sequencer instrument configuration. 

Note:  If you would like to control the multi-position valve manually during an MS Sensor run, simply 
create or load a valve sequence with no sequence steps.  You can then use the manual control 
section of the MPValve Sequencer window to increment, decrement, or move to a specific valve 
position. 

Other Options 

Log valve position changes to the event log:  If this check box is selected, an entry will be made in 
the MS Sensor event log to document the run time, valve, and valve position. 

Important:  This option should be disabled for long runs with many valve switches since the large 
number of log entries will produce a very large log file and potentially cause problems with system 
resources. 

Supported Signal Types 

The Diablo MPValve Sequencer instrument driver supports the following signal types: 
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Valve Position: 

This signal type returns the current valve position for the specified valve.  The valve is specified in 
Signal Index 1. 

Diablo EZReporter Instrument 
The Diablo EZReporter instrument is designed to import GC and GC/MS results exported from the 
Diablo EZReporter 4.0 software. 

EZReporter is a flexible post-run reporting program that retrieves and process calibrated (external 
standard) peak results from a large number of different chromatography data systems. 
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EZReporter Instrument Requirements 

You must download and install the EZReporter 4.0 software from the Diablo Analytical web site if 
you are not already using it: 

https://diabloanalytical.com/products/software/ezreporter/ezreporter-downloads/ 

IMPORTANT: make sure to download the version of the installer that includes support for the 
chromatography data system you are using to control your GC or GC/MS.  If in doubt, select the 
complete download listed under “Downloads for Other Data Systems”.  Choose the “Web Installer” 
if the computer is connected to the Internet, or the “Full Installer” if not. 

The software will run in a fully functional trial mode for 30 days after you install and start it for the 
first time.  You will need to purchase a license and activate the software to continue using the 
software after the trial period expires.  For simple export of results to the MS Sensor software, the 
Standard Edition of the software is sufficient. 

The EZReporter “Getting Started” manual and the “Connector Plugin” manual for your 
chromatography data system provide instructions on setting up EZReporter.  These manuals are 
installed along with the software or can be downloaded from the Diablo Analytical web site. 

https://diabloanalytical.com/products/software/ezreporter/ezreporter-downloads/
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Installation and Configuration of EZReporter 

The following assumes that you will be installing and running EZReporter on the same computer as 
the MS Sensor software.  Please contact Diablo Analytical support if you will be running EZReporter 
on a different computer. 

 

1) Install the EZReporter 4.0 software. 

2) Add the EZReporter Instrument to your MS Sensor method and install the MS Sensor 
EZReporter configuration templates. 

3) Set up EZReporter up to process component results from your chromatography data 
system. 

4) Set up your EZReporter configuration to export results to MS Sensor. 

5) Configure the MS Sensor EZReporter instrument 

Install the EZReporter Software 

Download and install the software on the computer running the MS Sensor software.  See 
“EZReporter Instrument Requirements” on page 87 above for download information. 

Once you have installed EZReporter proceed to the next step (Add EZReporter Instrument to MS 
Sensor Method) before starting EZReporter for the first time. 

Add EZReporter Instrument to MS Sensor Method 

Click the “Add Instrument” button in the MS Sensor method editor and select the “Diablo 
EZReporter” instrument: 

 

 
The EZReporter Instrument recipe editor will be displayed.  Click the “Install” button to install the 
MS Sensor EZReporter configuration templates: 
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Configure EZReporter for a New Installation 

For new installations with no existing EZReporter configuration file already set up for your GC 
method, you will create a new configuration from the MS Sensor template you installed above. 

When you start EZReporter for the first time, the New Configuration File Wizard will be displayed.  If 
you have already started EZReporter and have a default configuration file loaded, click, “File > New 
Configuration”. 

Select the “MS Sensor” Template Category: 
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The template, “MS Sensor Text Export.cfgt” should be selected by default. Click the “Next” button: 
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Check the “Edit configuration after saving” option, and then click the “Finish” button.  EZReporter 
will automatically open the configuration editor.  You will now need to enter the components from 
your GC method into the EZReporter Component Table. 

 

 

The configuration editor should open automatically to the Component Settings.  If not, click the 
“General Settings” option in the navigation bar at the lower left, and then, “Component Settings” 
from the list at the upper left.  You will now need to enter each of the components from your GC 
report into the Component Table. 

IMPORTANT:  EZReporter identifies components in the GC report by their component name.  So 
you need to enter each component with the exact spelling from the GC report.  Capitalization/Case 
isn’t important, but spelling is. 

You can edit the default “Component 1” by double-clicking that cell in the component table, and 
changing it to the name of the first component in your GC report.  You will add subsequent 
components by clicking the “Add” button and select a result type of “Peak Result”: 

 

A new line will be added to the component table, allowing you to enter the next component.  Repeat 
for the remaining components in your GC report. 

When you have completed entering your components, click the “Save” button to save your 
configuration. 
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Complete the Setup of EZReporter 

If you haven’t already set up an EZReporter instrument to process results from your 
chromatography data system, you should do that now as described in the EZReporter “Getting 
Started” manual and the EZReporter “Connector Plugin” manual for your chromatography data 
system. 

Finally, you should perform a run on your GC and confirm that the results are received by 
EZReporter and the Component Results in the EZReporter Sample Results tab match the results in 
your GC report. 

Making a run will also export results to the text file, which you will use to set up your MS Sensor 
method in the next step. 

Configure EZReporter for an Existing Installation 

If you have already set up EZReporter to process results from your chromatography data system, 
then all you need to do is modify the Text Export settings as described below. 

Open the EZReporter configuration editor and select the “Text Export” option in the “General 
Settings” section.  Set up the Export Control settings as follows: 

 

Next, switch to the Export Template tab, and enter the following template: 
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{StartCompLoop} 

{CompName}{Tab}{CompRawAmount}{Tab}{CompArea} 

{EndCompLoop} 

 

NOTE:  If you installed the MS Sensor EZReporter configuration templates as described in “Add 
EZReporter Instrument to MS Sensor Method” on page 88, then you can click the “Load” button 
below the export template window, and select the export template named, “MS Sensor Text 
Export.btx”. 

 

 

When you have completed setting up the export settings, click the “Save” button to save your 
configuration. 

Finally, you should perform a run on your GC and export results to the text file, which you will use to 
set up your MS Sensor method in the next step. 

Configuring the MS Sensor EZReporter Instrument 

After adding a new EZReporter Instrument to your MS Sensor method, you can edit the instrument 
settings in the Edit Recipe window. 
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Folder to Monitor for Results 

This is the folder that will be monitored for the “mss.txt” file that is exported from EZReporter at the 
end of each run.  You should only change this folder if you also change the export folder in the 
EZReporter Text Export settings. 

Stop run if EZReporter is inactive 

If enabled, this option will generate a fatal instrument error if no new results are received from 
EZReporter within the specified inactivity period.  The fatal instrument error will force the MS 
Sensor run to stop.  If you choose to enable this option, make sure to set the inactivity period to be 
comfortably longer than your GC run plus any additional sample preparation/injection time to 
prevent runs from being stopped inadvertently. 

Components 

This table should contain the list of components from your GC results that you would like to be 
available to assign to MS Sensor Signals.  It is important that the component names in this table 
match the spelling of the corresponding component name in the GC report exactly (however, 
capitalization/case is not important). 

You can manually edit and enter the components into this list using the “Add” and “Delete” buttons.  
However, it is better to use the “Import” option to import the list of components from the “mss.txt” file 
exported from EZReporter.  See, “Import Components” below. 

Import Components 

Clicking this button will retrieve the list of components present in the current “mss.txt” file exported 
from EZReporter and allow you to select which components you want to add to the EZReporter 
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Instrument component list.  You can choose to “Replace” the current component list or “Append” as 
new components to the current component list. 

 

This approach is easier than adding the components manually and ensures that the spelling of the 
component names is correct. 

IMPORTANT:  In order to use this option, you must have already set up EZReporter as described in 
“Installation and Configuration of EZReporter” on page 88, and exported results to the “mss.txt” file 
in the export folder. 

Install EZReporter Configuration Templates 

Clicking this button copies the MS Sensor EZReporter configuration template and export template 
files to the EZReporter templates folder.  See either “Configure EZReporter for a New Installation” 
on page 89 or “Configure EZReporter for an Existing Installation” on page 92 for instructions on how 
you can use these templates to configure EZReporter to export results to MS Sensor. 

Adding MS Sensor Signals 

Once you have set up EZReporter and the MS Sensor EZReporter Instrument, you can ad signals 
based on either the component peak area or amount. 
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Select the “Diablo EZReporter” Instrument, and then either a signal type of Component Amount or 
Component Area.  Next, select the desired component from the Signal Parameters. 

Refer to “Signals” on page 24 for more information on the various signal options. 
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Modbus Slave Server 

Overview 
The MS Sensor Modbus Slave Server provides Modbus TCP Slave functionality to communicate 
results to industrial process control computers and programmable logic controllers (PLCs).  Data 
Channel results can be assigned to a Modbus register for a Modbus Master to read. 

 

Modbus Module Specifics 
The Modbus implementation provided by MS Sensor 4.0 includes the following: 

• Implements Modbus TCP only.  Modbus via serial communications (RS-232, RS-422, RS-
485) is not currently supported. 

• Supports both Modicon and Enron/Daniel addressing. 

• Supports both single-precision Float and Int32 data in addition to standard 
Discrete/Bit/Boolean and Int16 data.  With Modicon register addressing sequential registers 
are used for Float and Int32 data, and the upper and lower sets of bytes can be swapped. 

• The Modbus registers are read only.  Write commands are ignored. 

What is Modbus 
From the Frequently Asked Questions (FAQ) page of the Modbus organization’s web site: 

“Modbus Protocol is a messaging structure developed by Modicon in 1979. It is used to establish 
master-slave/client-server communication between intelligent devices.” 

http://www.modbus.org/faq.php 

Modbus provides a standard way to transfer data between a data generating device like MS Sensor 
(the Slave) and a data consuming device like a programmable logic controller (PLC), human-
machine interface (HMI), supervisory control and data acquisition system (SCADA), or other 
process control system. 

A more detailed description of Modbus is beyond the scope of this manual.  Visit the Modbus 
organization’s web site using the link above for more information. 



Modbus Slave Server 

98 MS Sensor 4.0 Reference Manual 

About Modbus Registers 

With Modbus, a Slave device makes data available to a Master device through a “Register” that 
exposes numeric data held in an internal data table.  Each register in each data table has a unique 
address so that the Modbus Master knows how to access specific results. 

Important:  The Modbus standard defines 4 data tables, each with registers that can be addressed 
individually – two of those data tables hold read-only data, while two hold read/write data.  Since the 
MS Sensor Modbus Slave Server is read-only, it combines the two Int16 data tables (containing 
Holding and Input Registers) and the two Boolean/bit data tables (containing Coils and Input 
Discretes) to provide two read-only data tables.  The Modbus Master can still be configured to read 
all four types of tables, but the underlying data is the same for each of the two types of data. 

Modicon Floating Point and 32-bit Integer Support 

The original Modbus standard only supported two types of data: 16-bit integer (Int16) and single-bit 
(Boolean/Discrete) data.  Since signed 16-bit integers must fall in the range of -32,768 to +32,767, 
this provides a very limited option for exchange of data - particularly since most of the results 
generated by modern analytical instrumentation are floating-point (for example, 1.23456). 

Fortunately, since both single-precision floating-point data and 32-bit integer data can be 
represented by two 16-bit integers, it is possible to use two sequential Modbus Int16 registers to 
hold those integers.  One complication is that there is no official standard for which register should 
contain which integer, and different Master devices may handle this “byte order” differently.  To 
address this complication, the EZReporter 4.0 Modbus Module provides an option to swap Int32 
and Float bytes. 

Important:  By default, the EZReporter Modbus Module limits Modicon register addresses for both 
the Holding/Input table and Coils/Discretes table to a range of 1-2000 in order to simplify 
management of the Modbus configuration. 

Enron Floating Point and 32-bit Integer Support 

Some Master devices support an alternative to the standard Modicon approach of using two 
registers to hold 32-bit Floats and Int32 data.  This alternative approach is generally referred to as 
“Enron” or “Daniel” addressing.  In this approach, 32-bit Floats and Integers can be held in single 
registers.  However, the registers are restricted to specific address ranges: 

Enron Int32 Address Range:  5000-6999 

Enron Float Address Range:  7000-8999 

Important:  If you have added Float or Int32 results to your Modbus configuration and switch from 
Modicon-to-Enron or Enron-to-Modicon addressing, the Modbus Module will automatically re-assign 
the register addresses to the correct range. 

Configuring the Modbus Slave Server 
The MS Sensor Modbus Slave Server is configured by selecting the “Modbus Settings” option in the 
Method Editor. 
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Configure Server Settings 
To begin using the Modbus module, you should first configure the Modbus Server and Modbus 
register addressing settings.  Click the “Edit Server” button located on the Modbus Settings 
Window. 

The Modbus Server settings can usually be left at their default values.  However, it is very important 
that the Modbus Register Settings match the settings that the Modbus Master will use in order for 
the results contained in the registers to be read correctly.  This is particularly important for “Float” 
and “Int32” results (which represent most of the results from MS Sensor). 
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Server Settings 

The following settings apply to the Modbus Slave Server. 

TCP Port 

This is the TCP port on which the Modbus Slave Server will listen for connections from a Modbus 
Master.  The default port for Modbus TCP is port 502. 

Timeout 

This Timeout value is used by the Modbus Slave Server to determine if a Modbus Master is 
connected to the Server.  If the timeout period expires without a message being transmitted from a 
Master, then the Slave assumes there are no Master devices connected. 

The Timeout setting in milliseconds should be equal to or longer than the polling rate of the Modbus 
Master (the rate at which the Modbus Master checks for new results).  If you set the Timeout to a 
value that is too short, then the Server may not be able to detect reliably when a Modbus master 
has connected.  If you set the Timeout to a value that is too long, then the Server will not detect that 
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the Modbus Master has disconnected until after the Timeout period has expired.  The default 
Timeout value is 1000 milliseconds (1 second). 

Slave ID 

Each Modbus Slave device can be addressed by a unique ID number in the range 1-247.  Make 
sure that the Modbus Master is using the correct Slave ID when connecting to the MS Sensor 
Modbus Slave.  The default Slave ID is 1. 

Host Name 

The host computer name.  This is a read-only value that cannot be changed. 

Host IP Address 

The IP address of the host computer.  This is a read-only value that cannot be changed. 

Note:  The IP address displayed is for the primary network adapter, which is the first adapter in the 
binding order. 

Modbus Register Settings 

See “About Modbus Registers” on page 98 for details on Modbus registers and addressing. 

Modicon Addressing 

This option specifies the standard Modbus “Modicon” addressing protocol.  32-bit floating point and 
integer values are represented by two 16-bit integers placed in sequential registers.  To 
accommodate master devices with different expectations for which integer should be placed in 
which register, the Modbus module provides an option to swap the “byte order” for Float and Int32 
data. 

Enron/Daniel Addressing 

This option specifies the alternative Enron/Daniel addressing protocol.  If you choose this option, 
the Int32 and Float results will be restricted to the following specific register address ranges. 

Enron Int32 Address Range:  5000-6999 

Enron Float Address Range:  7000-8999 

Important:  If you have added Float or Int32 results to your Modbus configuration and switch from 
Modicon-to-Enron or Enron-to-Modicon addressing, the Modbus Module will automatically re-assign 
the register addresses to the correct range. 
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Modbus Address Shift 

Some Modbus Master devices may start counting the location of data in the data tables at 0, while 
others may start counting at 1.   The Modbus Address Shift setting allows you to account for these 
“counting” differences.  In general you will use either a value of “0” (typically for PLCs) or “-1” (the 
default value). 

Channel Register Update Delay 

These settings allow you to delay the update of all channel registers for a user-defined time/gate 
period after a stream selection valve has changed position.  This prevents signal disruptions caused 
by pressure/flow fluctuations and sample purging after a valve has been switched to a new 
source/stream from being reflected in the Modbus Chanel Register values. 

Delay/Gate Period 

The period of time, in seconds, after a valve change has been detected that the Modbus Channel 
Registers will retain their current value and not be updated.  The correct value should be 
determined experimentally and will depend on the details of the specific application including the 
dead volume of the sampling system and sample flow rates. 

Important:  It is important for the delay period to be less than the hold time for the positions/steps in 
the valve sequence. 

Valve Signals to Trigger Delay 

This list will contain all of the Signals in the current method that are linked to a Valve Controller 
Instrument (for example, MPValve Sequencer).  You must select (check) each valve signal in the 
list that you want to be monitored for position changes.  If the response of one of the 
checked/selected signals has changed since the last channel update, the gate/delay period will be 
started and the Modbus channel registers will remain at their current value until the gate/delay 
period has ended. 

Note:  If there are no valve controller signals present in the current method, then these options will 
not be available. 

Add or Edit Register 
The MS Sensor Modbus Slave Server provides a couple of easy ways to add registers to the 
registers table.  You can add single registers or you add a range of registers containing data 
channel results. 

Add a Single Register 

To add a new register to the Register Table in your Modbus settings, click the “Add Register” button 
on the Modbus Settings window: 
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You select from a list of supported MS Sensor results.  A description of each result is displayed 
when it is selected. Note that some results require an additional parameter to be selected:  for 
example, if you select a Data Channel Response result, you must also select the specific data 
channel.  If an additional parameter is required, a drop-down list box is displayed allowing you to 
select from a list of items: 

 

After selecting the result for this register, you must next select the register address that the Modbus 
Master will use to access this specific result (see “About Modbus Registers” on page 98 for more 
information on Modbus registers and addressing). 
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A list of available register addresses is pre-loaded into the list box.  This list will not include 
addresses that have already been assigned to other registers, and the range of addresses available 
will depend on the type of addressing you are using (Modicon vs Enron/Daniel).  While it is possible 
to enter a register address manually, it is safer to select from the list so that you don’t choose an 
invalid address. 

The Data Type (Boolean, Int16, Int32, or Float) for the selected result is displayed along with the 
corresponding register type.  If you are using Modicon addressing and the result is either a Float or 
Int32, then “2X” is also displayed indicating that this result will occupy two sequential registers (at 
the selected address and the next higher address). 

Finally, you can enter a description for this register/result.  This description is displayed in the 
register table to help identify each register: 

 

After setting up the register, click the “Save” button to add the new register to the end of the 
Register Table. 

Add Data Channel Registers 

If you want to add a Data Channel Response result for multiple channels to the register table, click 
the “Add Channels” button on the Modbus settings window. 

First, choose from the list of channels defined in the method that is currently loaded – the channels 
that are checked will each be assigned to an individual register.  You can click “Select All” button to 
check all of the components or “Select None” to uncheck all of the components. 
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The registers will be assigned sequential addresses starting with the address specified as the 
“Starting Register Address”.  The address list box is pre-filled with available starting addresses.  
Note that if the selected result is a Float or Int32 and you have specified Modicon addressing, then 
each result will occupy two sequential addresses. 

After making your selections, click the “Save” button.  A new register will be added to the end of the 
register table for each of the components that were checked: 
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Delete Registers 

To delete a register from the register table, select desired row(s) in the register table and the click 
“Delete Selected” 

 

The “Delete Registers” option allows you to delete multiple registers from the register table at once 
by selecting the rows of all of the desired registers to be deleted.  You will be prompted to confirm 
the deletion since deletion is not reversible. 

Print Modbus Configuration Report 

You can print a report of the current Modbus configuration (Server settings and Register Table) by 
clicking the “Print” button on the “Modbus Settings” window. 

Using the Modbus Slave Server 
If there are Modbus registers defined in a method, the Modbus Slave Server window will be 
displayed when you initialize acquisition. 
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The Modbus Slave Server window has two tabs: a Status tab that displays information about the 
server status, and a “Registers” tab that displays a summary of the registers that have been defined 
in the method, and their current value. 

Starting the Server 

In order for a Modbus Master to access the results in the Modbus register table via a TCP 
connection, the Modbus Slave Server must be started.  To start the Server click the “Start Server” 
button on the Modbus Slave Server window. 

 

Note:  You can also configure the Server to start automatically whenever MS Sensor acquisition is 
initialized.  See “Configure Server Settings” on page 99. 

Windows Firewall Exceptions 

If the Windows firewall is enabled on your system, you should see the following Windows Security 
Alert the first time you start the server.  Make sure you check the appropriate networks, and then 
“Allow Access” to add exceptions for the MS Sensor software to the firewall. 
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Important: If you are using a third-party firewall you will need to add exceptions manually for the 
EZReporter program and TCP Port you have selected (502 by default).  Please refer to your firewall 
documentation for instructions. 

 

Modbus Server Status 

The current status of the Modbus Slave Server is displayed on a color coded panel on the main 
Modbus Server panel: 

 

The Modbus Server status will display one of the following status messages: 

 

Status Color Description 

Offline Gray “Modbus Server is Offline” or “Modbus Server stopped 
by user” 

Starting Yellow “Starting up Modbus Server …” 

Started Green “Modbus Server started on TCP interface” 

Shutting down Yellow “Shutting down Modbus Server …” 

Error Red Details of the error message will be displayed 
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Stopping the Server 

If you want to stop the Modbus Slave server, click the “Stop Server” button on the main Modbus 
Module panel: 

 

Note:  If the server detects that a Modbus Master is connected, you will be prompted whether or not 
you want to stop the Server.  If you stop the Server with a Modbus Master connected, the Master 
will experience errors since the Slave will no longer respond. 

 

Note:  When you exit the Acquisition Control Panel, the Modbus Slave Server will be stopped 
automatically. 

Modbus Register Table 

The Modbus Registers table contains the list of registers that are currently defined. 
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The Register Table includes the following columns: 

 

#: The ID/Index number for the register. 

Register: The address of the register that the Modbus Master will use to access this 
specific result.  Note:  In Modicon addressing mode, Float and Int32 data 
types will occupy two sequential registers (Register and Register +1). 

Register Type: The Modbus table where the data for this result is stored.  The Modbus 
Module stores results in two types of data tables:  “inputRegister” (for 
Holding and Input registers) and “discreteInput” (for Coils and Input 
Discretes).  The register type used is determined by the data type of the 
result. 

Data Type: The data type defined for the result.  Options include Boolean 
(bit/discrete), Int16 (short, 16-bit integer), Int32 (long, 32-bit integer), and 
Float (single-precision floating point).  

Result: The result description for the register. 

Value: The current value of the register. 

Updating Register Results 

If the Modbus Slave Server is running, then the numeric values for each of the registers in the 
Modbus Register table will be updated whenever results are updated by MS Sensor during 
acquisition.  The current value of each register is displayed in the “Value” column of the register 
table. 
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Valve Sequencer 

Valve Sequencer Overview 
The MS Sensor integrated valve sequencer allows you to control and time sequence Valco 
Instruments (VICI) two-position and multi-position/selector valves via the RS-232 or USB serial 
interface. The valve position changes during a run are displayed in the event log and optionally as 
event markers on the real-time trend plots. 

Valve Sequencer Requirements 
The MS Sensor valve sequencer is designed to interface to Valco/VICI valves using either the EMH 
/EMT and EH/ET series micro-electric actuators or the EUH and EUT series “Universal” actuators 
using the RS-232 or USB serial communication interface.  Please contact VICI for information about 
their valves and actuators: 

Valco Instruments Company, Inc. (VICI) 

http://www.vici.com 

Configuring the Valve Sequencer 
The valve sequence settings are accessed in the main method tree.  You can either double-click 
the “Valve Sequence Settings” item in the method tree, or click the, “Edit > Valve Sequence 
Settings” menu option to display the sequence editor. 

http://www.vici.com/
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Configure Valves 

In order to create a valve sequence you must first define the valves that will be used in the 
sequence on the “Configure Valves” tab. 
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Click the “Add” button to add a valve to the current method.  The “Configure Valves” window will be 
displayed: 

 

 

Description 

The valve description can be changed to any desired text to better describe the function of that 
valve (“Stream Selection” for example).  This description is displayed along with the valve number 
on the Valve Sequence window during acquisition. 

Serial Communication Settings 

The VICI actuator control modules use fixed serial communication parameters, so you only need to 
select the Serial Port and optionally the Timeout setting.  The timeout setting is in milliseconds, and 
can be changed to a longer value in the event that you experience unexpected timeout errors 
during a run. 
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Once you have set the Serial Port, Actuator Type, and Valve Type to their proper settings for the 
selected valve, you can click the “Test” button to confirm that serial communication is working 
correctly.  If serial communication is functioning, you should see a window that displays the 
firmware information for the actuator control module: 

 

 

 

If serial communication is not functioning correctly a “Timeout” or other error message will be 
displayed.  If this happens, check that you have selected the correct serial port, the valve/actuator is 
powered, and the serial or USB cable is properly connected between the computer and 
valve/actuator. 

 

Actuator Type 

Select whether you are using a VICI “micro-electric” or “universal” actuator with this valve.   

Micro-electric actuator part numbers will generally start with “EMH” or “EMT” for multi-
position/selector valves, and “EH” or “ET” for two-position/switching valves. 

Universal actuators can control either multi-position/selector valves or a two-position/switching 
valves.  Part numbers for the universal actuator generally start with “EUH” or “EUT” 

Please contact VICI if you are unsure what kind of actuator you are using. 

 

Valve Type 

Select whether the valve is a multi-position/selector valve, or a two-position/switching valve. 

Important:  The Valve Sequencer currently only supports two-position/switching valves with stops.  
This is the most common type of VICI two-position valve used in typical applications.  However, 
please contact VICI if you are unsure what kind of valve you are using. 

Positions: 

For multi-position/selector valves, the actuator needs to know the number of positions there are in a 
full rotation of the installed valve.  Enter the number of positions into the text box.  The exit port on a 
multi-position valve should not be included in this count. 

Find Stops: 
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If you are using a two-position valve with stops and the universal actuator, the “Find Stops” button 
will be enabled.  When you click this button, the valve sequencer will attempt to connect to the 
actuator, and if successful will instruct the valve to find the valve stops automatically. 

Important:  Make sure that you are connected to a two-position valve with stops before using this 
command. 
 

Port Labels 

You can add descriptive labels for each port/position on the valve.  These descriptive labels are 
displayed along with the port/position number on the Valve Sequence window during acquisition. 

The Sequence Table 

Once you have configured the valves that will be controlled during the sequence, you can create a 
sequence table.  Each sequence step is defined by a “Step Type”, “Valve”, “Valve Port/Position”, 
and hold time.  The sequence steps are applied in the order shown in the sequence table. 

 

 

Add/Edit Sequence Step 

To add a new step to the sequence, click the “Add” button.  The new step will be appended to the 
current sequence table. 
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Step Type 

There are three types of sequence steps: 

PreRun:  PreRun steps are executed while the MS Sensor run is in the “PreRun” state. All PreRun 
steps must be completed before the MS Sensor run will reach “Ready” status.  PreRun steps are 
typically used to purge the valve and  sampling system lines before the run is started.   

SequenceStep:  SequenceSteps are executed in the order they are listed in the sequence table 
once the MS Sensor run is started.  When all of the SequenceSteps have been executed, the 
sequencer will proceed based on the “End of Sequence” setting you have selected. 

PostRun:  PostRun steps are executed after the MS Sensor run had finished.  You might use a 
PostRun step to purge the valve and sample lines with an inert gas. 

PreRun and PostRun steps are displayed with a yellow background in the sequence table, while 
SequenceSteps are siplayed with a green background. 

 

Valve 

Select the valve that will be used for this step from the list of configured valves. 
 

Position 

Select the new position/port for the selected valve. 

Hold Time 

Set the hold time in minutes that the sequence will wait before continuing to the next step. 

Add Range 

The "Add Range" button can be used to append multiple steps to the sequence table. 
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Valve 

Select the valve that will used for the range of sequence steps. 

 

Starting Position 

Select the first valve position/port you want to add to the sequence table. 

 

Number of Steps 

Enter the number of steps that should be added to the sequence table.  A positive number will 
result in the valve position being incremented in each step.  A negative number will result in the 
valve position being decremented in each step.  The valve position will "wrap" if the starting position 
and number of steps exceed the maximum number of positions available on the valve. 

 

Hold Time 

Enter the hold time to enter for each step in the range. 

 

Delete Steps 

Click the “Delete” button to delete the step(s) currently selected in the sequence table.  You can 
select a sequential range of steps to delete by selecting the start of the range and shift-clicking the 
end of the range. 

Rearrange Steps 

You can reorder steps in the sequence table by left click the step number of the desired step, and 
dragging it to a new location in the sequence table. 

Note: you can only move steps within the same region of the sequence table.  You can’t, for 
example drag a sequence step into the pre or post sequence section.  If you want to change a 



Valve Sequencer 

120 MS Sensor 4.0 Reference Manual 

sequence step to a different step type, you must edit the step and change the sequence type 
manually. 

Sequence Options 

The Sequence options allow you to define the general behavior of the sequence. 

 

 

Sequence Control 

Disable Sequence 

This option is used to temporarily disable the execution of a sequence when you make an MS 
Sensor run.  If this option is checked, the Valve Sequence window will not be displayed during 
acquisition, and the sequence won’t execute. 

End of Sequence 

These settings determine what happens after executing the last line in the SequenceStep section of 
the sequence table. 

 

Repeat Continuously 

The sequence will repeat continuously until stopped by the user. 

 

Stop After Cycles 
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The sequence will stop and execute any post-run steps after repeating the sequence the specified 
number of cycles.  A “cycle” is defined as one complete pass through the Sequence Steps section 
of the sequence table.  If you select this option, you must enter the number of cycles to execute. 

 

Stop after Minutes 

The sequence will stop immediately and execute any post-run steps after running for the specified 
number of minutes.  If you select this option, you must enter the desired number of minutes. 

Note:  If you don’t select the “End MS Sensor run when sequence ends” option below, the MS 
Sensor run will continue after the sequence has stopped.  In addition, when the MS Sensor run 
stops, the valve sequence will always be stopped. 

 

Stop Sequence 

The sequence will stop and execute any post-run steps after executing the last line in the sequence 
table. 

 

End MS Sensor run when Sequence ends 

If you check this option the MS Sensor run will be stopped when the valve sequence stops.  If this 
option is unchecked, then th MS Sensor run will continue after the sequence stops. 

Other Settings 

Display valve switch event markers 

If you check this setting, vertical event markers will be added at the run time that corresponds to 
each time a valve is switched to a new position during the run.  Each event marker includes a label 
at the top indicating the new valve and position (V:N, P:N). 
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Import MPValve Sequencer Sequence 

Click the “Import” button to load a sequence file that was created for the MPValve Sequencer 
software.  You will be presented with a file browser to select the desired sequence file to import.  
MPValve Sequencer sequence files have a “.SEQ” file extension and will be located in one of two 
locations: 

1) If the sequence file was created for use with the MS Sensor MPValve Sequencer instrument 
plugin, it will be located in the MS Sensor “Methods” folder: 
 
C:\Users\Public\Documents\Diablo MS Sensor 4.0\Methods 
 

2) If the sequence file was created for use with the standalone MPValve Sequencer program it 
will be located in the Diablo MPValve Universal installation folder: 
 
C:\Program Files (x86)\Diablo MPValve Universal 
 

Important Note:  The MPValve Universal valve configuration is stored separately from the sequence 
file.  Consequently, it is possible for the current valve configuration to be incompatible with an older 
sequence file.  If such an incompatibility is detected when importing the sequence file, the valve 
sequencer will create the required number of valves for the imported sequence.  However, you 
must edit those valve configurations in order to make them consistent with both your valves and 
sequence. 

Once the sequence file has been imported, you should review the resulting valve configuration, 
sequence table, and sequence options to confirm they are correct.  In addition, you can add valve 
descriptions and port labels. 

Running a Sequence 
If you have created a sequence table with one or more steps, and you have not checked the 
“Disable Sequence” option, the “Valve Sequence” window ill be displayed when you click the MS 
sensor “Acquire” button to start a run.  This window allows you to monitor execution of the 
sequence during the MS Sensor run. 
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The acquisition Valve Sequence window has the following sections: 

Sequence Table 

The current sequence table is displayed in this window.  PreRun and PostRun steps are displayed 
with a yellow background, while the SequenceSteps are displayed with a green background.  The 
step that is currently executing will be selected automatically, and during the run will be displayed 
with a blue background. 

Valve Table 

The current valve configuration is displayed n this section.  The valve table includes the current 
valve status, valve description, and the current position/port.  If you click the position cell for a 
particular valve in the valve table, a button ([…]) will be displayed.  If you click that button a window 
will be displayed allowing you to control the valve position manually outside of the sequence.  See 
“Manual Control of Valve Position” below for more information. 

Sequence Status 

The current status of the sequence is displayed in this section, including the sequence run status, 
current cycle, and the current step, valve, and position being executed.  A progress bar displays the 
progress of the current hold time. 
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Manual Control of Valve Position 

You can control the position of any of the valves in the valve table by clicking the “Position” cell and 
then the “[…]” button that appears on the right edge of the cell to display the Manual Valve Control 
window. 

 

 

You can increment (->) or decrement (<-) the position of the selected valve, or send the valve to a 
specific position by selecting it in the “Go To Position” list. 

Important:  You should close the Manual Valve Control window once you have finished since it may 
interfere with other MS Sensor functionality. 

Valve Sequence Data 
Valve switch events and the position of valves during a run are displayed in the event log, real-time 
data table, and optionally as event markers on the real-time trend plots.  In addition the valve 
position at each point in the acquisition is saved in the MS Sensor data file. 
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Real Time Data Grid 

Additional columns will be added to the real-time data table for each valve configured in the 
method.  The columns are added immediately after the run time column and are given a column 
heading of the valve description. 

 

Event Log 

Each valve position change is automatically recorded in the event log: 
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Trend Plots 

As described in “Other Settings” on page 121, you can enable valve switch markers on the real-time 
trend plots: 

 

Data Files 

Both valve switch events and valve positions during a run are saved to the MS Sensor data file.  
When results are exported to CSV/Text files the position of each valve during each acquisition cycle 
is automatically included in the data channel results: 

 

Data Viewer 

The MS Sensor Data File Viewer has been enhanced to display valve switch event markers from 
the run.  If valve switch events are detected in the data file, they are displayed automatically: 
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You can toggle the visibility of the event markers by right-clicking the plot window and checking or 
unchecking the “Display Valve Event Markers” menu option. 
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Troubleshooting 

Review the Event Log 
When an error occurs with the MS Sensor software, always view the detail of any error message in 
the event log.  Error events are colored with a red background, so they are easy to identify.  You 
can also select “Errors” in the Event Log filter and only error events will be displayed. 

You can view the detail of an error event by double-clicking on the line containing the error event in 
the Event Log.  The Event Description may provide useful information on the cause of the error. 

You can copy the error details to the Windows clipboard by clicking the “Copy” button when viewing 
the event.  Those details can then be pasted into an email message to send to support. 

 
 
The error/event source and error/event description, including any error numbers, can be very 
helpful in identify the cause of a problem. 
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Debug Logging 
Enabling debug logging can provide helpful information when troubleshooting software errors 
messages or other issues.  Enable debug logging by clicking, “Tools > Enable Debug Logging”, and 
then see if you can reproduce the error.  Debug logging will write additional information to the log 
file that can be helpful when troubleshooting problems. 

You can view the current log file by clicking “Tools > View Current Log File”. 

The log file is named “mssensor.txt” and is located in the folder: 

C:\ProgramData\Diablo Analytical\MS Sensor 4.0 

You can view this folder by clicking “Tools > “Browse System Folders > ProgramData Folder”. 

Support Files Archive 
You can create a “Zip” archive of all system log files, method files, and data files by selecting, “Save 
Support Files to Archive file” from the main “Tools” menu.   
 

 
 
You can choose to include the current method file, data file, and event log database, and also add 
other MS Sensor data file folders (.D) to the archive if they help to illustrate the problem.  Save the 
Zip archive to the Windows desktop, or browse and select another location.  You can then email 
this zip file to Diablo Analytical support along with a description of the problem and steps to 
reproduce it. 
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